
User Guide Edition 2018



About UltraSeps Version 3

Welcome to UltraSeps Version 3, the most powerful, accurate and feature
rich color separation solution available to screen printers!

UltraSeps v3, is the fifth generation of our original product, QuikSeps
released in 1999 and is the successor to UltraSeps v2, our previous high-
end color separation program released in 2012.

UltraSeps Version 3 primarily adds increased simplicity, speed, error
reduction technology and the ability to install to all of your systems as no
additional charge.

UltraSeps is developed by Steve Roginski, a screen print industry veteran
of over 30 years and avid Photoshop user since the first commercial
version was available in 1990.

Every form of color separation required by the t-shirt screen printing
industry is available using UltraSeps. Basically, if UltraSeps doesn’t pro-
vide it, you’ll most likely never need it!

UltraSeps v3 is extremely easy to use. The program does an excellent job
of insulating end users from the complexities of Photoshop.  Only a mod-
est learning curve is required and even Photoshop novices will be able to
generate high quality separations during the very first day of use.

Please take the time to explore the user guide.  Although containing many
pages as UltraSeps includes an immense number of features,  its heavily
illustrated and therefore won’t take a great deal of time or effort to read.

The user guide was primarily written on a Windows computer using Adobe
Photoshop CS4 for the vast majority of screen shots as it utilizes informa-
tion from the original UltraSeps user guide of 2009.

This version of the user guide is the 2021 edition.  Changes and correc-
tions are throughout although the major change to UltraSeps is no longer
needing to submit a Request Number to us to unlock UltraSeps on your
systems.  Updated and clarified information on printing separations to film
is covered as well.  We assume the vast majority of information within to
remain valid for at least a decade from publication date.  If a major
change occurs with new versions of Photoshop as released, they will be
addressed on our website.

Enjoy UltraSeps Version 3!

Steve Roginski
UltraSeps Developer
Extreme Sportswear, Extreme Graphics Technology LLC
www.ultraseps.com  /  info@ultraseps.com
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What’s New In UltraSeps Version 3

Changes That May Not Be Obvious At First Glance

UltraSeps v3 features updated plugins, JavaScript’s and Actions to ac-
commodate future changes to operating systems, Photoshop and system
CPU’s.

Version 3 also runs considerably faster and is virtually immune to any
type of issue or error.  In fact, it also includes a function to run that
checks if all in installed correctly.

Due to these updates and the removal of the driver software distributed
with UltraSeps previously, UltraSeps Version 3 should cover your color
separation needs for the next decade or more and have zero issues with
yet to be released versions of Photoshop, Windows, Mac OS, and should
also be compatible with the new (non-Intel) CPU Apple is switching to in
2021.

Major Changes

The upgrade not only features new plugins, scripts and actions, but we
have also eliminated the Request Number – Unlock Code scheme with
Version 3.  So what does this mean?  Well, once installed it will simply
run on your system!

Want to install it to your other systems and laptop for example?  No
problem!  Just run the installer, launch Photoshop, load the Actions and
you’re all set to go!

No hassle!  Not possible to get locked out of the software!  Easily install
at any time if needed to a new system!

All we ask is to please not redistribute, share or give away the
software!

This does not infer that a single copy should be shared by count-
less users!  If more than a few users are to access UltraSeps at
your shop, please play fair and purchase a copy for each additional
user or at the very minimum, pair of users for those with large art
department staffs.  Years have gone into developing UltraSeps and
believe me, putting something together such as this isn’t easy!

Improvements, Changes and Additions When
Compared To UltraSeps v2:



UltraSeps v3 will simplify using UltraSeps when getting a new system,
swapping hard disks, migrating to different systems, etc. It also protects
you in the very unlikely event of something catastrophic happening to all
here involved with UltraSeps as we never want our users locked out of
the program.

Both Windows and Macintosh installers are included. Running the in-
staller will install an authorized copy of UltraSeps v3 to your system. It
will also overwrite a previous installation (if applicable) which is advisable
to do as any future licensing issues will be avoided.

If you have installed UltraSeps previously, such as the trial version,
following purchase just download and install Version 3.  The installer will
overwrite the existing copy of UltraSeps v2 or the trial version.

Version 3 also includes a new set of Actions. These Actions are similar to
the Version 2 Actions with changes to reflect the change in licensing.

The Actions also include a function to test if UltraSeps v3 has been in-
stalled correctly. If forgetting to use the new Actions, UltraSeps v3 will
still run with the older set of Version 2 Actions.

The installers as of the publication date of this user guide support
Photoshop versions beginning with CS3 through the latest releases of
Photoshop Creative Cloud.

Improvements, Changes and Additions Continued:



This User Guide contains links to each subject within the
Bookmarks Sidebar of Adobe Acrobat Reader.

Click the Bookmarks Icon to reveal links to the contents.

The User Guide is best viewed with a recent version of Adobe Acrobat Reader.
Download a free updated version here: http://get.adobe.com/reader/

This Area Intentionally Left Blank



Installing UltraSeps Version 3 - Windows

Download UltraSeps Version 3.

Unzip the file downloaded.

Decompressing the Zip file will result in a single folder
named UltraSeps v3 Windows.

Place this folder on your desktop for easy access.  It contains all required files.

Do not delete this folder following installation.

Close Photoshop if open.

Run the correct installer file (32 bit System or 64 bit
System) within the
UltraSeps v3 Folder for your computer.

It doesn’t matter what version of Photoshop you’re using,
CS3-4-5-6-Creative Cloud, etc.
Simply run the installer designed for your system.

It could take a while to begin installation, up to several minutes as the installer
needs to search for all installed copies of Photoshop.

If the install seems to be taking too long however, look at your System Tray on
the bottom of your screen.  Most likely Windows is flashing a warning asking if its
okay to proceed.  Not all systems will ask for permission to proceed.

Once complete, the plugin and support files needed to run have been installed.

You are now ready to open Photoshop to install the
UltraSeps Actions and Color Settings file.  See pages 8-9.

We provide all additional test images, distress filters, updates and support files as
downloads from our website to registered users.

UltraSeps requires Adobe Photoshop CS3 or higher.  All versions of Creative Cloud
are supported.

UltraSeps runs on Windows XP, Vista, Windows 7, Windows 8, Windows 10 and
higher.  Both 32 and 64 Bit.

If a new or different copy of Photoshop is installed at some point in the future,
see the section on how to install to a newly downloaded version of Photoshop.



Loading The UltraSeps Actions

Launch Photoshop and open the “Actions
Palette”.

If not visible on your screen, go to the
“Window” menu within Photoshop and
check “Actions”.

Click the downward facing arrow at the
top right corner of the actions palette and
select “Load Actions” as illustrated.

Now locate the UltraSeps v3 Windows or
UltraSeps v3 Mac Actions file from the
UltraSeps v3 folder on your desktop, or
wherever you may have placed it and click the
Load Button.

Once UltraSeps v3 has loaded into
your actions panel, expand the folder
to view its contents and it should
appear similar to the graphic here.

Again click the downward facing arrow at the top right corner of
the actions palette and select “Button Mode”.  This is how you’ll
want to run UltraSeps.

Using the Actions in Button Mode will avoid malfunctions result-
ing from clicking the modal boxes accidentally (these are the
small icons and check marks next to the actions pictured in List
View above.) These also appear within the actions themselves
and will damage them if changed.

Rest assured if deciding button mode is not for you and for some
reason the actions malfunction, simply delete the entire set and
reload a fresh copy.  A few functions of UltraSeps must be run
with the Actions in Button Mode however.

If many other actions are loaded into your Actions Panel in
addition to UltraSeps, Button Mode may then provide a confus-
ing view.  In that case, use List View and trigger an action by
selecting it and clicking the Play Arrow at the bottom of the
Actions Palette.



Loading The UltraSeps Color Settings File

The final step to installation is to configure Photoshop to render separations
correctly when running UltraSeps and to adjust for black ink generation.
This step is required to run color separations that will print accurately and
also display properly on screen.  Modifying Photoshop’s Color Settings is
very simple and requires the automated loading of a single file.

Note:  Its normal for the RGB, CMYK, Gray and Spot Working Spaces to include the term QuikSeps.
These are the correct settings.

Go to the UltraSeps Actions recently
loaded and click the
“Load UltraSeps Color Settings” button.

This loads the UltraSeps Custom Color.csf
file into Photoshop.

If now choosing Edit > Color Settings from Photoshop’s
menu bar, you’ll see the color settings have been changed.



Loading the “UltraSeps Custom Color.csf” file is vital to the operation
of the program and cannot be omitted!

If its not loaded, the channels will not render correctly thus making accurate
adjustments impossible as dot gain isn’t compensated for.

A backup copy of the UltraSeps Custom Color.csf file can be found within the
UltraSeps v3 folder inside the Backup Files Folder if for any reason you’d
ever need to load the file manually.

A Final Important Word On Color Settings:

Its very possible and likely that previously saved art or files from other
sources will generate an Embedded Profile Mismatch Warning when
attempting to open with Photoshop while using the required UltraSeps
Color Settings.

This is nothing to be too concerned with.

Simply check the Convert Document Color or the Discard Embedded
Profile button and click OK.



Download UltraSeps Version 3.

Unzip the file downloaded.

Decompressing the Zip file will result in a single folder named UltraSeps v3
Macintosh.

Place this folder on your desktop for easy access.  It contains all required files.

Do not delete this folder following installation.

Close Photoshop if open.

Run the installer package within the UltraSeps v3 Folder.

If getting an Unidentified Developer Warning and/or the
installer will not run due to Apple’s excessive security,
control-click the installer and choose Open.

The installer will now run.

This is due to the Apple store not being aware of UltraSeps
and trying to prevent the installation in addition to the
restrictive security of the latest releases of Mac OS.

Once complete, the plugin and support files needed to run have been installed.

You are now ready to open Photoshop to install the
UltraSeps Actions and Color Settings file.  See pages 7-8-9.

We provide all additional test images, distress filters, updates and support files as
downloads from our website to registered users.

UltraSeps requires Adobe Photoshop CS3 or higher using Macintosh.

UltraSeps requires an Intel processor based Mac or higher.  It does not run on
older Power PC Macs.

UltraSeps v3 should also run on new yet to be released Macs that use non-Intel
processors.

The single installer will install UltraSeps for all versions.

If a new or different copy of Photoshop is installed at some point in the future,
see page 14.

Installing UltraSeps Version 3 - Macintosh



Previous Version Indicator!  How To Fix!

If the Try-Buy-Unlock-Quit window or the Expiration Window below appears
when running UltraSeps v3, the old version (v2) is still installed.

Quit Photoshop and run the UltraSeps v3 installer.  Make sure it completes!

After doing so, relaunch Photoshop and try again.  If still there, then for some
reason the old plugin has not been overwritten by the installer and needs to be
deleted manually (which would be unusual)

Go to your Photoshop folder and open it.

Now, open the folder named Plug-ins.

Delete ALL Plugins with UltraSeps in their name (if present).

Next, within the Plug-ins Folder, look for a folder named Automate
(if one exists).

Open the Automate Folder (if applicable) and delete ALL Plugins with UltraSeps
in their name.

Next, run the installer with Photoshop closed then open Photoshop and try
again.

All should now be functional.



Note:  The installer has placed folders on your system
named “QSU” and “UltraSeps”.  These folders and their
contents are accessed by UltraSeps only.  There are no
end-user files within.  Deleting or moving these folders or
any of their contents will render UltraSeps nonfunctional.

Installation Test

After running the installer with Photoshop closed, followed by opening
Photoshop and loading the Actions, it’s a good idea to run the Action to test if
all has been installed correctly.

The Action is the fifth from the top and named Installation Test!

Simply run the Action and respond to the prompts.

If reading the success message box and no errors have been generated, and/or
a dialog box does NOT appear asking you to Open a file, then UltraSeps v3 has
been installed correctly.

If an 8800 error is generated, this indicates the UltraSeps Plugin is not installed
to Photoshop.  Quit Photoshop and run the installer again.  Be certain the in-
staller completes.

If the file Open dialog box appears, or a Missing JavaScript message appears,
you have likely not run the installer and are missing files.  If so, run the in-
staller.



How To Manually Install UltraSeps Plugin

If after running the installer, restarting Photoshop and loading the Actions into
Photoshop an error is generated when trying to use or test UltraSeps such as
the following:

"8800 Command Unknown Not Available"

"8800 Command QS Not Available”

This indicates the UltraSeps Plugin is not installed to Photoshop.

If generated, make sure you have in fact ran the installer with Photoshop
closed.  Also be certain the installer has completed.

If the error persists, then likely Photoshop is not installed to its default location
or the Photoshop version folder has been renamed by the end user.  If this is
the case, the UltraSeps Plug-in will need to be installed manually which is easy
to do!

Manually installing the plugin will resolve an unknown version of Photoshop
issue as well.

The next 2 pages cover how to manually install the
correct UltraSeps Plugin using different versions of
Photoshop as an example.

Although if Photoshop is installed to its default location
and not renamed, manually installing the plugin should
not be necessary.



How Manually Install UltraSeps Plugin (If Needed)
Photoshop CC 2017-2018-2019-2020-2021 and Later:

Close Photoshop.

Now go to the UltraSeps v3 Folder you have downloaded previously con-
taining all the files.

Open the folder containing the files for the version in use, Windows or
Macintosh.

Open the Backup Files Folder.

Inside the Backup Files Folder open the Plugins Folder. Inside this folder
are multiple UltraSeps Plugins. Make sure to select the correct one!  Do
not double click these in an attempt to run them!

The plugin needs be copied to a specific place within the Photoshop
Folder manually. If on Macintosh, the correct plugin is labeled for the
copy of Photoshop in use. On Windows, the correct plugin is labeled for
the bit version of Photoshop (32 bit or 64 bit)

Now locate the Adobe Photoshop folder currently in use and open it.

Make sure its the copy being used!

Next, open the Plug-ins Folder inside the Photoshop folder.

Copy the correct UltraSeps Plugin to the Plug-ins Folder of Photoshop.

Restart Photoshop if running.

Load the UltraSeps v3 Actions into the Actions Panel of Photoshop if not
done so already.

Run the Action to load the UltraSeps Color Settings.

UltraSeps should now be functional. If not, then you have likely copied
the wrong UltraSeps Plugin to Photoshop. If so, remove the current Ul-
traSeps Plugin and copy the other version and restart Photoshop.

Make sure only 1 UltraSeps Plugin (the correct copy) is there. Errors will
be generated if more than 1 UltraSeps Plugin is installed.



How Manually Install UltraSeps Plugin (If Needed)
Photoshop CS3 - Photoshop CC 2015.5:

Close Photoshop.

Now go to the UltraSeps v3 Folder you have downloaded previously con-
taining all the files.

Open the folder containing the files for the version in use, Windows or
Macintosh.

Open the Backup Files Folder.

Inside the Backup Files Folder open the Plugins Folder. Inside this folder
are multiple UltraSeps Plugins. Make sure to select the correct one!  Do
not double click these in an attempt to run them!

The plugin needs be copied to a specific place within the Photoshop
Folder manually. If on Macintosh, the correct plugin is labeled for the
copy of Photoshop in use. On Windows, the correct plugin is labeled for
the bit version of Photoshop (32 bit or 64 bit)

Now locate the Adobe Photoshop folder currently in use and open it.

Next, open the Plug-ins Folder inside the Photoshop folder.

If a folder named Automate does not already exist inside the Plug-ins
folder, create one.

Copy the correct UltraSeps Plugin to the Automate Folder for your copy
of Photoshop and system.
Once again, the Automate Folder is inside the Plug-ins Folder of
Photoshop CS3 - CC 2015.5.

Restart Photoshop if running.

Load the UltraSeps v3 Actions into the Actions Panel of Photoshop if not
done so already.

Run the Action to load the UltraSeps Color Settings.

UltraSeps should now be functional. If not, then you have likely copied
the wrong UltraSeps Plugin to Photoshop. If so, remove the current Ul-
traSeps Plugin and copy the other version and restart Photoshop.

Make sure only 1 UltraSeps Plugin (the correct copy) is there. Errors will
be generated if more than 1 UltraSeps Plugin is installed.



When Installing A New Photoshop Version

At some point, a new or different version of Photoshop will probably get
installed to the computer currently in use by UltraSeps v3.

Following a newly installed version of Photoshop Creative Cloud

If installing a new Creative Cloud version of Photoshop from a previous
Creative Cloud version, UltraSeps v3 should automatically copy itself to
the new CC version.  The only end user requirement is to run the Action
to load the Color Settings.

Get UltraSeps v3 Running With A Newly Installed Older Copy Of
Photoshop CS3-CS4-CS5-CS6

If installing a new OLD version of Photoshop prior to Creative Cloud, the
UltraSeps v3 installer will need to be ran again with Photoshop closed.
Then open Photoshop to load the Actions followed by running the Action
to load the Color Settings.

If Photoshop Is Installed To A Non-Default Location

Our installers assume Photoshop is installed to where it should be lo-
cated.

C:/Program Files/Adobe on Windows
or in the Applications Folder on Macintosh.

If located elsewhere, the plugin will not get placed by the installer and
will need to be installed manually.

Instructions on how to manually install the plugin can be found on the
previous 2 pages.



Basic Rules Of Operation

The user guide covers every form of color separation, adjustment, enhancement,
etc.  Here’s a basic head start of what’s expected from the end user.

Although UltraSeps v3 contains logic so no errors are ever generated when trying
to run a separation on an incorrectly prepared file, there are a few things you
should know.

The most important aspect to remember is if
intending to use an underbase and highlight
white, the file needs to be “transparent”, such
as the image on this page.

There can be no layers or backgrounds filled
with white or the art itself surrounded by white.
If there is, obviously this is seen as white ink
and will be generated within the white under-
base and highlight channels.  This is fact, if
using UltraSeps or not to color separate with.

Although I could write a script to remove all
white surrounding the image, this would also
remove most whites within the art itself.  There
is no guaranteed automated way to determine if
the white is part of the image or not.

If not planning on using an underbase or high-
light white, then it doesn’t matter if the image
contains white surrounding the art.

For optimum results, the art should be bright,
clean and colorful with adequate color satura-
tion and file resolution.  Small 72 dpi jpegs
taken from websites just won’t do.

Avoid working in and assembling art in CMYK
mode at all costs since this destroys color.
ALWAYS work in RGB mode!  If wanting to run
a CMYK separation, prepare the art in RGB mode and let UltraSeps handle the
conversion.

The file can be named anything you desire.

Once satisfied with the appearance of the art, save it and you’re ready to go!

Make sure no other files are open within
Photoshop when running a separation!

Continued..........



Decide what kind of separation you’d like, Simulated Process, Index, CMYK,
Grayscale, Specialty etc. from the Actions and Click!

If you don’t have a file ready to test, the program contains sample images ready to
separate.  In fact, for those new to UltraSeps, we highly recommend running a few
different color separations on the test file named “Space Shuttle” just to get a feel
for the program.

When all on-screen activity stops, the separation process is complete.

Make Sure To Review The Entire User Guide!

I highly recommend to continue with the User Guide for in depth instruction.  The
first few pages will help getting up-to-speed with file preparation.  The remainder is
structured by starting with the top of the UltraSeps v3 Action Set and working our
way down.  By the time you’re done, you’ll be ready to tackle demanding jobs, even
for those who are fairly new to Photoshop and color separation.

I’d like to stress again that UltraSeps v3 is very tolerant of processing files which
are not formatted correctly for use.  This is especially helpful to those new to the
program as it eliminates much confusion.  No other color separation program is as
easy and intuitive.

Enjoy yourself and Welcome to the Power and Simplicity of UltraSeps v3!

This Area Intentionally Left Blank



Checkerboard Behind The Image Indicates Transparency
File is in RGB mode.

Notice there are no Layers filled with a solid color such as white.

Although UltraSeps v3 will correct most all mistakes in file format, the sample
here illustrates a perfectly formatted image.  The most important aspect is the
“transparency” as in no solid white or other color filling all non-printing areas.

Many Photoshop users make the mistake of “Flattening” images once a
project is completed.  Additionally, customer supplied art created with
Photoshop is usually supplied flattened or merged with white.

This is a big mistake, even for those who don’t use UltraSeps since it
makes future modifications such as moving or modifying an element of the
art difficult since you’ve essentially pasted the art to a white sheet of pa-
per.  UltraSeps will “see” that background white as white ink and add it to
the underbase and highlight channels.

There are 2 methods to prepare your art. The first is to simply to do it
correctly from the start if possible. The second is deleting all non-printing
background area from the file to be separated.  Next we’ll discuss several
methods on art preparation and converting a flattened image to a trans-
parent file.

Optimal Image Formatting Example



Preparing New Artwork With Photoshop

We’re fairly certain most users will quickly open some preexisting art and
throw it at UltraSeps just to see things work on their files.  And I’m also
sure most have artwork ready and waiting to separate.  However, its
probably a good idea to briefly discuss file preparation, especially for
those newer to t-shirt graphics, UltraSeps and Photoshop.

Create a new file with slightly larger dimensions than you intend the
finished color separated file to be and make sure to select “Transparent”
as its contents.  Set mode to RGB and select 8 Bit.  Resolution should be
200 dpi minimum - 300 dpi maximum.  Don’t worry about it being the
exact size as this can be adjusted or cropped later.

Now simply add your graphics / text / etc. to the transparent file. Since
its easier to work against a white or black background, add a new layer to
the bottom of the layers palette and fill this layer with white or black.

You can add both a white and black filled layer (or another color) if you
wish and toggle them on and off. The sample on the following page illus-
trates a multilayer file.  This is how art is assembled using Photoshop but
is NOT the correct format to run a separation on!



Typical Art File With All Data
Layers Visible & Active

The artwork above is complete and needs to
be color separated. Obviously the layers
should be merged together with the exception
of the White BG and Black BG layers but this
needs to be done “without” flattening the
image.
Here’s how to do it......

Remember, its VERY IMPORTANT to
save the original file “AS IS” with all layers
intact.  It might be needed for future
modifications!

Duplicate the file and close the original
saved version.

Have all layers containing image data on
the duplicate file visible (make sure the eye
is next to each required layer) and delete
all unwanted layers.

If using a Black / White filled Layer for
viewing, make sure to delete those also!
Now click the arrow in the upper right
corner of the Layers Palette and select
“Merge Visible”.



The Layers Panel should now resemble the
sample below with one transparent Layer.

The Channels Panel should only contain the RGB
Channels and nothing else.

The next few pages discuss using a file from an illustration program such
as Illustrator or CorelDraw in addition to modifying an existing file that

has been flattened containing solid white or black around the image.

This merges all visible channels WITHOUT flattening the image thus leav-
ing transparency surrounding the art which is a requirement of UltraSeps.

If white, black, etc. surrounded the image, UltraSeps will obviously see
that as ink.  In fact, ALL color separation programs and those trying to
manually separate the art will see it as ink, not just UltraSeps.

After merging the visible layers we’re left with one remaining layer con-
taining the entire image. Photoshop will name the single remaining layer,
Layer 0.



Using Files From Vector Programs

Unless vector images are very basic or consist of clearly defined and
limited number of hard spot colors, they’re probably better suited to be
separated in Photoshop.  This is especially true with clipart graphics as
they can contain an immense number of colors.

Photoshop can easily open Illustrator, CorelDraw and vector images from
other graphics applications.  Just save them as a PDF.  Newer versions of
Photoshop can work with Illustrator files natively if needed.

Illustrator images and elements can also be copied to the clipboard, a new
blank document created in Photoshop, then pasted in as pixels.

When opening an Illustrator
PDF or other PDF file within
Photoshop, the Import PDF
dialog box appears.  Set the
resolution to 300, Mode
RGB and Bit Depth to 8 bit
then click OK.

The file will be rasterized
and open as a transparent
document on a single layer.

When opening an EPS file
within Photoshop, the
Rasterize EPS Format dialog
box appears.  Set the resolu-
tion to 300 and Mode to RGB
then click OK.  The file will be
rasterized and open as a
transparent document on a
single layer.  If possible, avoid
using EPS documents as they
can experience slight color
shifts.  Stick with PDF.

The screen shots below use Photoshop CS4.  Newer versions CS6 - CC
are similar.  Earlier versions of Photoshop may appear differently

although the basic settings are the same.



In all likelihood, some of your art is flattened, consisting of a Background
Layer which obviously translates to all non-printing areas outside the
image opaque like the sample below.

When confronted with a flattened image, you’ll need to change it to a
single layer document.  Double click on the background layer and when the
layer dialog box appears, Photoshop will unflatten the image and rename
the old Background Layer, Layer 0.  The image is no longer flattened
which permits the removal of all opaque non-printing areas.

Deleting A Background Color - Flattened Image

Although the image is now a Layered image and not flattened, the white
opaque area outside the image and in closed areas such as within the text
needs to be deleted.  Several methods are available to achieve this de-
pending on image complexity.  We’ll discuss the two simplest, although
most effective methods here.



The easiest and most accurate way to remove a
solid background color from an image with well
defined edges (such as the example here) is with
the Magic Eraser Tool.

Unlike using the Magic Wand, it doesn’t leave
residual pixels behind and takes the color off
cleanly.

The default Tolerance for the tool is set
at 32, which is normally too high.  This
can be lowered if needed to render the
tool less sensitive to colors similar to
that being removed.  A setting as low as
1 can be used.

If clicking the tool removes a portion of
the image when a very low tolerance
setting is selected, this is due to a void
area which isn’t closed that contains a
very similar color.  Simply undo the
delete, zoom in on the problematic area
and using the brush or pen tool, close
the open area with solid color.

Add a temporary layer under Layer 0 and fill it with Black or another high-contrast
color.  This will make viewing easier as non printing areas are deleted.  Now simply
click all opaque areas outside the image and within places where no ink should print.
DO NOT delete any white from areas where white ink is required!

Once satisfied, delete the temporary layer filled with black and save.  The file is now
ready for use.



The easiest way to remove a background color
from complex images that might have “almost
white” edges, smoky areas, soft feathered
elements, etc. is by using the
Background Eraser Tool.

After selecting it from the Tools Panel set the Tolerance at 20%.  This can be adjusted
higher or lower depending on the image.  Add a temporary layer under Layer 0 and fill
it with Black.  This permits easier viewing as non printing areas are deleted.  Create a
large “hard edge brush”,  I’ve used a setting of 200 here.

Now simply click all opaque areas outside the image, overlapping the brush with each
click.  Once all non printing background color areas close to the image have been
deleted,  use the magic eraser or another selection tool and delete the remaining
perimeter areas.   DO NOT delete any white from areas where white ink is required!

Once satisfied, delete the temporary layer filled with black and save.  The file is now
ready for use.

The Background
Eraser was able to
remove the solid
white background
while leaving the
blue glow intact.



UltraSeps v3 includes 10 image enhancements:
Not all are illustrated in the user guide.

Ultra Image Fix is a color enhancing sequence to
help improve an RGB image.

Ultra Image Fix Intense is a more potent form of
the above to be used on images of very poor quality.

Ultra Black Correction adds black depth to images
with washed out blacks.

Ultra Brighten Shadows is a major improvement of
our old Brighten Define Image as it assists in revealing
image details while not overly impacting color fidelity.

Ultra Sharp is a basic preset unsharp mask which
clarifies the Lightness Channel in LAB Mode and then reverts the file back to RGB.

Ultra Repair Jpeg does a great job on smoothing out rough images and removing
artifacts from jpegs. Its also quite helpful to remove halftone screens from scans
taken from magazine photos, catalogs, etc.

Ultra Low Resolution Enhance helps in making lower-res images usable. No, it
won’t turn that matchbook size jpeg into full chest artwork but is very useful on
most files.

Ultra Low Resolution Enhance XL is similar but increases the file resolution
approx 25% further than Low Resolution Enhance.

Sharpen Enhanced Image is used following the Low Resolution Enhance Filters to
improve clarity.

Saturate Enhanced Image is used following the Low Resolution Enhance Filters to
improve color intensity.

Pre-Separation Image Enhancement

Original Image
Ultra Image Fix

IntenseUltra Image Fix



Ultra Brighten Shadows
This filter digs out detail, highlights and hidden color within images.   Unlike at-
tempting to use a curve, levels adjustment, saturation or combination of such, this
process did not compromise the integrity of the graphic and brought a dreary, dull
image to life.  It can be run multiple times if needed.  If your image is also a bit
soft, consider adding Ultra Sharp.

Ultra Sharp
Since the Ultra Sharp Filter doesn’t attack colors within the image, it does a better
job of sharpening without leaving behind strange artifacts or intensifying preexist-
ing issues.  It can be run several times if needed.
Not intended for use on low resolution images.



Ultra Repair Photo-Jpeg
This filter does a great job of smoothing out rough images and removing artifacts,
grain, etc. from jpegs. Its also quite helpful for removing halftone screens by scans
taken from magazine photos, catalogs, etc.  Works as well as many stand-alone
commercial file repair plug-ins.  Some images respond well to Ultra Sharp following
the use of this filter.

Ultra Low Resolution Enhance - Standard & XL
Sometimes you’ll get an image that just isn’t “quite” good enough to use.  Or
maybe you’ve bought some images on-line and really need the resolution and
clarity higher.  Then simply run Ultra Low Resolution Enhance on the file!  This
function works best repairing low quality images that are physically larger to begin
with.  Please, don’t expect to convert a matchbook size 72 dpi jpeg into perfect full
chest sized artwork!  “Nothing can offer that as its simply impossible”.

The example below, zoomed in for display purposes began as a 96 dpi jpeg at
about 60% final output size.  Ultra Low Resolution Enhance was able to increase
the resolution and clarify the image substantially.  This process can be used effec-
tively on both photographic and hard-line style graphics.

The XL version is essential identical but increases the physical dimensions of the art
approx 25% larger.

After running Ultra Low
Resolution Enhance, it
may be necessary to
sharpen and/or saturate
it a bit further using the
2 actions to follow.

NOTE!  If using Ultra
Image Fix or the Ultra
Brighten Shadows
Action, always run
Low Resolution En-
hance “first” for satis-
factory results.



Simulated Process Color Separations

UltraSeps v3 includes three completely different simulated process color separation
functions named UltraSeps Sim Process #1, #2 and #3.  They are quite different
from one another so experiment with them all as an image may separate more
accurately with one as opposed to another.  There is no “one best way” to do
things, so we have provided multiple choices.

Running UltraSeps simulated process is the EASY part of the color separation pro-
cess.  In fact, if ran using a high quality file that is bright, clear and with sufficient
color information there may be little need to adjust any of the color channels.

Even if adjustments are needed, it’s usually only a bump of the Curves Function on
a channel containing either too much or too little intensity or the simple deletion or
merging of one or a few color channels.

Check List Prior To Running Any Type Of Color Separation:

UltraSeps automatically works on a duplicate of your image so its not required to
save another version as a “work file”.  Just remember to name the completed color
separation differently.

I hate to beat a dead horse but lets review the correct file setup method:

All non-printing areas of the image such as outside the art needs to be transparent
(checkerboard background) so the white underbase and highlight white channels
render correctly.

If possible, setup the image as a single layer document.  This is not an absolute
requirement although a good idea.

Your file must be in RGB format with no additional channels other than the Red,
Green, Blue and composite RGB channel visible or contained within the channels
palette.

For the best results, file resolution should be 200 dpi to 300 dpi. Although UltraSeps
will produce adequate separations at slightly lower resolutions if the situation
arises.

Resolutions above 300 dpi increase file size, slows down the separation process and
does not improve quality on most images.  Art containing hard lines and small text
however could benefit from slightly higher file resolutions.

Make sure the UltraSeps Color Settings have been loaded into Photoshop.  If not,
run the Action to load them.

Do not have any other files open within Photoshop.  The only file open should be
the file to be separated.

Now lets do a simulated process separation using Sim Process #1.



Click UltraSeps Simulated Process #1 RUN
and when all on screen activity stops, the
separation is complete.

When UltraSeps Simulated #1 completes the separation, go to the channels panel
and turn off the R-G-B channels and shirt background channel.  Now sequentially
turn on color channels that may be included within the image.  A good start is the
yellow, aqua, blue, soft red and black option 2.  Then experiment with how other
channels impact the file at that point.

Next decide which of the 3 black channels works best with the art, which of the 4
underbases (if any) you’ll be using, what color channels can be deleted or com-
bined into another and make a decision if the alternate Red Channel that we call
“Soft Red 185” looks better than the standard Red 185 Channel.

When printing on darks which are NOT black OR when deciding to run a black ink
on black shirts to retain detail, use the “White Base (Non Blacks)” channel or see
generating an Alternate White Base which removes less black from the white un-
derbase.  We’ll discuss this later.

If the image is to be printed on black without the use of black ink, view it with the
shirt background channel selected with an underbase.  Additional black data can
be removed from the white underbase if needed to increase contrast.



Consolidating The Color
Channels Automatically.

Use With A Simulated #1 Separation Only!

For those choosing not to merge and/or
delete channels manually using a separation
generated with Simulated #1,  we’ve included
a simple set of Actions to merge and delete
some of the color channels to reduce the final
number of colors.

Merging the Aqua channel could get a bit
tricky especially if there’s some green in the
image.  If so, it’s best to not merge this
channel.

If the art is green intensive or a vital part of
the image is green, you’ll need to keep the
green channel itself then merge some of the
Aqua 311 with the Blue 285 and Yellow 102
channels.  Once satisfied, delete the Aqua
Channel.

Many images won’t absolutely require a highlight white.
If being printed on white, the base could be eliminated.
If printed on black, the black ink could be omitted (sometimes).

I think you get the picture.  Reducing the colors to a minimum helps the small
press owner with images that might require the addition of a special color like a
metallic, puff, gel, neon, brown, fleshtone, etc.

The subject of merging channels and using varying opacity settings in the Apply
Image Function of Photoshop is covered in detail later on in the user guide.

After merging or deleting all unwanted channels, at this point deciding which
underbase, black and red channel works best with the art is the final step.

The next 15 pages or so discusses adjusting a simulated process separation.
We’ll go over adding custom color channels, adjusting channels and the under-
base, merging channels and more.

Following that, we’ll review the Simulated #2 and Simulated #3 functions of
UltraSeps.  Working with channels using those color separation options are
identical to working with a separation generated using Simulated #1.

We’ve also included a fourth simulated process color method called Basic 5 Color
Simulated that is great for simple jobs.  We’ll discuss this later in the user guide.



Once decided upon what channels are to be retained and output to film, the most
basic of all adjustments to improve image quality is a simple Curve.

Usually increasing or decreasing the intensity of cer-
tain Channels is all the simulated process separation
needs to look great both on screen and on press.  An
example of popular Curves are illustrated below and I
highly encourage experimentation with this tool.

Higher-end or more difficult separations some-
times require adjustments beyond a simple
Curve.   Fortunately, these changes are quite
simple.

We discuss removing/adding data from one
channel to another and generating custom color
channels later in the user guide.

Basic Channel Adjustment



All references to Photoshop’s
Curves Function within the user
guide assumes your Curves are
setup identically to ours.

Notice the lower gradient bar is
set left-to-right, light-to-dark.
Yours must be set this way!

In older versions of Photoshop,
click the right lower gradient bar
to change the setting.  In newer
versions, click the Pigment/Ink %
button pictured here.

This Area Intentionally Left Blank



Adding A Custom Color Channel To The Separation

The new channel is
named Spot Channel 1.
Its the correct color and is
generated by running an
RGB Calculation on your
selection.  If another
custom channel is gener-
ated, its name will be
Spot Channel 2.

The channel name, color
and intensity can be
adjusted accordingly.

To darken the channel,
use the Darken Custom
Color Action.  It can be
used more than once if
needed.

Click the “Custom Color Channel RUN”
Action and follow the instructions on screen.

When Color Range opens, select your cus-
tom color using the eyedropper, adjust
“Fuzziness” to select the proper amount of
color and make sure the Invert Box is
checked. Click OK and the program gener-
ates a new spot channel.



Adding - Merging One Channel To Another

Often you’ll find it useful to merge one channel with another.  It can be used to
reduce the number of channels, to intensify a channel in key areas, to add a
specific channel’s data to the white underbase so that top color prints brighter on
dark substrates, etc.

In the example here we’re going to add the Flesh 155 Channel to the Brown 7515
created earlier by using the Custom Color Channel Action.  This will ensure the
custom brown channel has enough color and also eliminates the need to run a
flesh or tan ink.

I selected the Light Brown 7515 Channel in the channels panel then clicked the
Merge-Subtract Channel Data Action.

When the Apply Image window opens, we changed the Blending Mode to Multiply,
Opacity to 100%, UNCHECK the Invert Box and selected the Flesh 155 Channel.

Setting the opacity at 100% will copy all of the selected channel to the
target channel.  So pay attention to the Opacity Setting and experiment
with settings less than 100% if the target channel seems to too dark.

More often than not, an opacity setting of less than 100% is used.



The graphic above displays the custom brown channel before and after applying
the flesh channel using Apply Image.  Notice the overall improvement and how
the ink blends more naturally.

Original Custom
Brown Channel

After Merging With
The Flesh Channel

The channels most often merged into one are the Aqua 311 and Blue
285.  Usually the Aqua will be the channel merged into the Blue 285.
When merging these two channels, pay careful attention to the amount
of Aqua added to the Blue with the use of the Opacity setting in Apply
Image.

Once merged, experiment with changing the color of the Blue 285
channel to a brighter, lighter blue.  Most art, aside from those with
deep blues will benefit from the change in color following the merge.

Take note of the “Solidity Settings” of the channels above at 10%.
These settings do not affect film output whatsoever and are set only to
preview the separation correctly on screen.  If they were all set to
100%, you’d have no idea how the separation will actually perform on
press and making accurate adjustments in Photoshop would be impos-
sible.  UltraSeps uses different settings for certain channels.



Deleting Channel Data From Another Channel

At times you’ll find it useful to remove a given channels data from another chan-
nel.  In our example here, we’re using the Custom Spot Channel, Light Brown
7515 and we’d like to remove some of the brown from the Soft Red 185 Channel
so the image prints clean and not too red.

We selected the Soft Red Channel in the Channels Panel and clicked the Merge-
Subtract Channel RUN Action.

When the Apply Image window opens, we changed the Blending Mode to Screen,
checked the Invert Box and selected the new Brown 7515 Channel.  Click OK.
Much of the Brown data has now been removed from the Soft Red Channel.  If we
needed to remove the brown further from the red, simply run the sequence
again.

Note, in our example some of the brown information will remain within
the red.  This is normal when using this tool and won’t adversely affect
printing.

The Opacity Setting of
the Apply Image
function can be set to
any number up to
100% for times when
you’d like to remove
less data from the
target channel.  Its
especially useful when
running Apply Image
more than once on
the same channel.

Using A Loaded Selection To Delete Data From Another Channel

Another and possibly easier method to remove the data of one channel from another
is to load a channel as a selection.  First make sure the background color in
Photoshop’s tools panel is set to white.  Now CTRL-Click in Windows or CMD-Click on
Mac the channel you’d like to “load”.  Once loaded, select the channel to remove the
loaded data selection from.  Depress the delete key and information from the loaded
channel will be removed the selected channel.  If the Fill Window opens when hitting
the Delete Key, choose White, Opacity 100% and Blending Mode Normal.  The delete
key can be depressed multiple times to take away more data if needed.



Pictured here is what you’ll see when
UltraSeps completes running the simu-
lated process action named
“Sim Process #1 RUN ”.

At this point the colors can be automati-
cally reduced by using the various
actions included or the end user can
simply look at each channel and decide
which should be kept, deleted or
merged / subtracted from another.

The action pulls multiple whites, blacks
and reds.  Select which looks best for
the art and discard the remainder.

Since the Sim #1 Action generates
colors which are not obviously used in
every job, the automatic numbering of
the channels for print order (#1, #2,
#3 etc.) is not possible:

Remember, Light Colors First, Dark
Colors Last (usually - not always).

Use caution with the orange as it
repeats certain red data.  Its useful
on some files although not all.

Its okay to move channels up or down
to obtain desired results.  Consider
changing channel colors to better match
the original image along with using
Photoshop’s adjustment tools to lighten
or intensify the ink of single or multiple
channels to achieve the desired effect.

Reminder:  When double-clicking a
channel to bring up its properties
you’ll notice a “Solidity Setting”.

These settings allow the channels
to display correctly on-screen and
make accurate adjustments pos-
sible.  They do not affect the film
output.  Even if changed to 100%
the films would print identically.

Simulated #1 Full Channels Panel



This simple Action intensifies the opacity of a white
underbase channel while not greatly affecting light
shadow areas or overall contrast.  Run more than
once if needed.

Increase Ink White Base

High Contrast White Base
Removing Black Ink Data From The Underbase

Its possible that you’ll need to remove additional black ink data an existing
white underbase to guarantee a black ink is not required when running black
shirts.

To accomplish this, run the “High Contrast White Base” on the white under-
base channel to be used and follow the on-screen instructions.  The action
further defines the base and permits efficient use of the black shirt color.

If the Fill Window opens when hitting the Delete Key, choose White, Opacity
100% and Blending Mode Normal.

Running Black Ink On Black Shirts

When running black ink on black shirts to achieve
maximum quality and contrast, its a MUST to reduce
the total amount of black ink within shadow areas.
Failing to lighten the black channel selected for
output will result in a dark image on press.

Use a curve to lighten the black as you’ll want the
black channel to appear somewhat washed out yet
retain full opacity within 100% solid areas when
running on black shirts.

Its also helpful to run black ink on 330 - 355 mesh
as opposed to 280 or 305 with black shirts.  The
higher mesh count controls the ink deposit more
effectively than constantly adjusting squeegee/
floodbar pressure and speed throughout the run.

Whenever possible, I would always run a black ink
on black tees as it simply looks better when com-
pared to using the black color of the shirt to repro-
duce all blacks.



If the Alt White Base is not dark enough, run the “Increase Ink White
Base” Action.  Its okay to run multiple times if required.

To add the new white underbase or dark highlight to your separation, select
Photoshop’s Move Tool, select the channel in the palette, hold down the shift
key and drag it to window of the separated file.  Holding down the shift key
will align the new channel with your other colors perfectly.

Although UltraSeps Sim #1 generates 4 different white underbases, sometimes
none are quite right.  UltraSeps removes much of the black ink data from the #1-
#2-#3 underbases so these are primarily used for blacks if no black ink is used.
When working with a red, royal, bright green etc., dark background on screen, a
color cast from the shirt background color will be seen in many areas.

This is due to the removal of white ink within most areas containing black.  There-
fore, when printing on a dark substrate other than black, the White Base (Non
Blacks) channel should be used along with running black ink.

Since we’re fanatical on offering multiple choices, we’ve added the ability to gener-
ate yet a different
and excellent white
base for use on
non-blacks without
running a full sepa-
ration named “Alt
White Base - High-
lights” Action.

To use this, open
the original image
file, the one with all
image data on the
single transparent
layer and run the
Action.

Upon completion
you’ll have a file
like the sample
here.

White Base Info & The Alt White Base Highlight Action



What we did here was
change the background
color of our separation to
an awful shade of green.

The top image is with
one of the #1-#2-#3
white underbases, the
bottom with our new
Alternate Underbase.
Notice the green cast is
now gone.  The cast will
also be gone using the
White Base (Non Blacks)
channel.

When running non-black
shirts, you MUST have
some white ink within
shadow areas as the
black tints and other
darker top colors such as
reds, blues and browns
are not strong enough
without that little extra
white ink within key
areas.

I use this base quite
frequently along with the
White Base (Non Blacks)
when running non-black
dark shirts.

Remove Fringe Pixels From White Base Action

If your underbase looks as if its ever so slightly clouding the background (non-
printing) area when viewing the separation on a dark shirt background or if small
white fringe pixels or noise is present, this action will remove it.

Select the white base and click the Remove Fringe Pixels From Base Action.
Basically it deletes pixel data of 5% or less from the base which doesn’t affect the
quality or performance on press.



Many times its needed to selectively modify the white underbase.  Usually this
means darkening areas under a specific ink such as red or blue for example so
these colors print brighter on darks shirts.

This is best accomplished by using the Merge-Subtract Channel RUN Action which
invokes the Apply Image Function.  We’ve discussed the use of this previously
although its vital to review it again here as it relates to the underbase.

In our example we’re going
to add the Soft Red 185
Channel to the White Base
to help brighten the reds
further on the shirt.

Start by selecting an under-
base channel and then click
the Merge-Subtract Channel
action or just open Apply
Image in Photoshop.

In the Apply Image window
select the Soft Red 185
Channel, set the Blending
to Multiply and Opacity at
100% to apply all the data
and click okay.

Selectively Modifying The White Base

All of the Soft Red 185 Channel has now been added to the white underbase so the
red ink prints brighter on darks.

Obviously if less pixel data is required, use a lower opacity setting.  If more is
needed simply repeat the process.

As opposed to using our Action to load the Apply Image window,
within Photoshop’s menu bar go to Image > Apply Image.



Become An Opacity Junkie!

After doing some jobs, you’ll get to know what works for you and one of the most
powerful tools in Photoshop is the built-in densitometer within the Info Panel.

Its not only helpful for taking readings on the base, but every other channel too.

If 85% white for example works well under solid red, just shoot for that number
on the next job.

In fact, I never do a separation without extensive use of this on every channel.

Don’t color separate blindly...be a pro and use that Info Panel!



Choking The White Underbase

Turn off all channels except the white underbase and the shirt
background.  Make the white underbase the active channel by
selecting it.   With the magic wand tool shift-click on all blank
areas surrounding the underbase channel.  Don’t forget to also
include isolated areas which are not initially selected by clicking
outside the image.

This Is Worth Repeating!
Choking the underbase is more important with images that are comprised
of or contain hard, clearly defined boundaries or objects such as large
text which are to be printed on a dark substrate.

We’ve designed each underbase to be as accurate as possible and made adjust-
ments that help in decreasing excessive intensity of the outer edges.  Most of the
time choking the underbase is not required, especially with photograhic and busy
images.

You may find it necessary however (at times) to choke the white underbase a bit to
avoid white image data from spreading beyond the borders of your image.  This is
more of a factor with images that have hard, clearly defined edges such as solid
areas of large text.  Utilizing a coarse mesh for the white underbase or when deal-
ing with less than ideal printing conditions are other reasons for choking the under-
base.

The best way to decide if your white underbase of choice needs a touch of shrink-
age is to closely examine the edges at a magnification of 200% with the white
underbase, all color channels you intend on using, in addition to the black shirt
background channel selected within the channels panel.

If it’s “clearly apparent” that unwanted white ink is creeping beyond your top col-
ors, UltraSeps has an to action to address the problem and will choke the white
underbase by 1, 2 or 3 pixels.

If attempting to test or use these on a low resolution file of say 100 dpi, the effect
will be greatly exaggerated.

Choking the white base cannot be totally automated and requires the user to select
the canvas surrounding the white underbase along with isolated inner areas such as
gaps inside of text using the magic wand tool.

First, select the magic wand tool and lower the tolerance to a factor of 1.



After selecting all areas outside the image along
with any isolated spots, the next step is to finish
the task by using one of the UltraSeps actions to
choke the underbase by 1, 2 or 3 pixels.

Click one of the actions pictured at the right then
take a look at your underbase at 200% magnification with all top colors visible.

If it appears as though a higher setting is needed, either undo the action and try 3
pixels or run the 1 pixel action to take off a bit more.

It’s important not to overdue this.  Too much of a good thing will begin to deteriorate
the underbase.  If just a touch of underbase is visible beyond the top colors, most
likely it will not affect the image as top colors have a natural tendency to expand
slightly on press and hide minor flaws.



Choking Portions Of The Underbase

Certain images might contain both hard, clearly defined edges and soft faded
elements thus making auto choking somewhat difficult.  When presented with
such an image, here’s a great method to only choke the “hard areas” while leav-
ing softer parts, which could be damaged untouched.

Start again with the Magic Wand tool with a Tolerance setting of 1.  As before,
shift-click outside the underbase and within any confined areas.  Now from
Photoshop’s “Select Menu” choose Modify > Expand and enter 2 pixels.  A higher
pixel setting can be used if needed.

Select the Eraser Tool
with a hard edge brush
at 100% Opacity Setting
and manually erase
along the edges that
require choking.

Don’t worry about eras-
ing into the image area
since its protected by
our selection.  Only the
outer 2 pixels in the
example are “live” and
can be erased.

Always make certain the background color within
Photoshop’s tools panel is set to White when using the
eraser tool!



Generate Discharge Underbase

When running Discharge Inks, the white base needs to be modified.
Unlike a traditional white base, a discharge base only requires white ink
where white is actually seen within the art and not under all top colors.

After completing a simulated process separation, one of the white base channels
will require modification using this Action.

The Action will modify the white base you intend on using to work properly with
discharge inks.

Normal Underbase
After Running

White Discharge Base

The modified base may include a small amount of discharge white under certain
top color areas. This is expected and will not adversely affect the image quality on
press.

The Action does NOT generate a stand-alone white base, it modifies a preexisting
white base that UltraSeps has generated.

Prior to running, the intended White Underbase Channel needs to be the selected
active channel within the Channels Panel.

Upon completion, the White Underbase Channel will be named “White Base Dis-
charge Ink”.

Discharge separations do not require a highlight white so its okay to delete it.

This Action requires the RGB Channels to be intact!  If the RGB Chan-
nels have been deleted, the underbase generated will be useless!



UltraSeps Simulated Process #2

General Info On Sim Process #2

UltraSeps Sim Process #2 generates simulated
process color separations somewhat differently
when compared to Sim #1 and Sim #3.  It has
become a favorite of many users and has been
updated slightly in UltraSeps v3.

With some art, such as those containing tans and fleshtones, these separations
help mute the reds within tints to assist in generating those colors using the
extended Mute Highlight Channel.  This helps printers with smaller presses gener-
ate these colors reasonably well without using the actual inks.

With other files, its suggested to use the Dark Highlight White as the Mute High-
light is most likely too strong.

The Black Channels are also different with the #1 Black used as the primary
selection, the Heavy Black includes a great deal of shadows and is excellent to
adjust while the Light Black is great when using black ink on black shirts.

The White Underbases, Yellow, Blue, Teal and Red Channels are also generated
employing different methods when compared to the Simulated #1 Action, so the
final separations are not identical. This is a completely different simulated process
program.

The separations generated are extremely accurate and many will prefer this
method above Simulated #1.  Usually, a Curve to lighten or darken a channel is
all that’s needed to get these seps to work with most files.  In fact, you’ll have
less need to merge channels using it.

The only channels you’ll find yourself merging regularly to reduce total number of
colors are the Teal and Blue channels.  And for those with smaller presses, merg-
ing the Green channel with the Yellow and Blue to avoid running a Green ink for
jobs not highly green intensive.

Clicking the Sim Process #2 RUN Action generates the entire color separation.

Please note the Magenta Channel generated by Simulated #2 is a Spot Magenta
and not a process color!

Do not use any of the Auto Reduce Color Actions with these
separations as they are specific to the Simulated #1 output.



The Sim Process #2 RUN Action generated the separation illustrated here.

It provides a white underbase for black shirts and non-blacks, two blues, green,
red, magenta, flesh, brown, gray, mute and dark highlight whites and three
blacks.

Take note the Black Heavy Channel contains a great deal of black shadow and
will be too intense for most work (as is).  This special Black channel generates
the maximum amount of black data possible while not being destructive.  Its
intended purpose is to provide a black channel option to adjust, usually lighter to
obtain a level of black ink the end user is comfortable with.

The Black Light Channel is far too weak for jobs printed on non-blacks.  Its in-
tended primarily for running black ink on black and very dark substrates for
maximum contrast.

End user selected custom color channels can be added to these separations by
using the Custom Color Channel Actions and-or the Flesh - Earthtone Actions.

UltraSeps Simulated #2 Separation



The illustration above documents the orignal RGB image and a basic
unadjusted separation.  No additional custom color channels were used
to generate the screen shot as its composed of basic colors generated
running the Sim Process #2 Action.

Color Separation Original RGB Image

Simulated #2 Highlight Whites

Although most of your files may
not include flesh intensive areas
such as large faces, an image such
as this is an excellent example for
reviewing the use of the special
highlight channels of Sim Process
#2.

The separation above looks great
but on press with limited colors
and without using flesh inks, the
red would dominate the areas
masked here in bright green.



No Highlight Dark Highlight Mute Highlight

Turning on the Dark or Mute Highlight Channels not only adds highlight white to the
white areas, its also adds a small amount of white to overprint the red tints and a
touch within golden yellows.  We got this idea from the Dark Highlight introduced
with QuikSeps and is used within our CMYK separations to help mute the magenta
channel on problematic images.

These extended highlights have a more dramatic effect on screen as opposed to on
press.  In fact, the Dark Highlight will perform similar to a normal highlight channel.
Those with smaller presses attempting to print an image such as this or any image
with tans, dark golden yellows, flesh, etc. will achieve a higher quality result when
using the Mute Highlight.

Adjusting The Highlight Whites

If you’d prefer to use a more tradi-
tional highlight without the additional
muting, select a highlight channel
and use a curve similar to the this.

Select the lower Curve handle and
enter 4, 5, 6, 7, 8, etc. within the
Input Box.  The Curve diminishes the
muting effect.

Or just click the Lighten High-
light Action.  Click several times
until the desired amount is removed.



The above is the result of clicking the Lighten Highlight Action twice on the Dark
Highlight Channel of Sim Process #2.  Doing so transforms the slightly muted high-
light channel into a traditional highlight.  The end user might choose to adjust the
highlight in this manner for use with art not benefiting from the muting effect.

Dark Highlight Channel Adjusted To Normal Highlight

Same Separation Before And After Highlight Adjust

Two identical separations before and after adjusting the highlight white. Notice the
only change is the muting within the flesh and golden yellow areas.  All other areas
of highlight remain mostly unchanged.



Since we already discussed most vital points regarding the adjustment and
modifications of simulated process separations earlier within the Sim Process
#1 pages, there’s no reason to further discuss working with an UltraSeps
Sim Process #2 separation here.

If needing to merge channels, add or delete data from one channel to an-
other, modify the base, generate custom color channels, etc., simply refer to
those pages earlier within the user guide.

So lets move on to UltraSeps Simulated Process #3.

This Area Intentionally Left Blank



UltraSeps Simulated Process #3

General Info On Sim Process #3

UltraSeps Sim Process #3 generates simulated
process color separations differently by assem-
bling most color channels using a Pure Color
Mode.  Its possible that some channels can be
somewhat cleaner in appearance since they’re not
influenced by black or gray data within the art.

UltraSeps Sim Process #3 is a “hybrid” color separation function.  It generates its
channels using both traditional RGB data along with a Pure RGB Channel that is
void of all gray and black data.  Some files respond quite well to this method and
its simply another tool to consider when color separating files using UltraSeps v3.

Some of the differences you’ll find using Sim Process #3 are the Red and Yellow
channels may include more color information.  The Red 185 channel will be darker
within areas where golden yellow, tan and fleshtones are seen.  This dynamic can
be an advantage however with files containing yellow to red blends which is com-
mon with a high percentage of images.

The Light Blue 305, Royal Blue 300 and Green 354 channels will exhibit less
“overlap” when compared to other forms of simulated process separation.  For
example, if its a true Green, you’ll find most of its data within the Green 354
channel and not also within the two blue channels.

With artwork that isn’t green intensive, the Green 354 channel can be merged
with the Light Blue 305 and the Yellow 102 channels to generate green on press.
However, if the art is that of a Heineken bottle for example,  the Green 354 needs
to be included.

The Flesh 149 channel also does a good job of selecting flesh and tan and is quite
different from all other flesh channels generated using UltraSeps.  The Gray 428
channel is usually more intense when compared to the gray from a Sim #1 or #2
separation.

I’ve tried to keep the initial separation as simple as possible and have included
only 2 underbases, one engineered for black shirts and another for non-blacks.
Only one black channel is generated therefore if using black ink on a black shirt to
assist with contrast, use a Curve in Photoshop to lighten it.

If additional color channels are needed, such as a specific color Sim #3 has not
provided, use the Custom Color Action of UltraSeps to pull the needed channel.



Standard RGB Data RGB Minus Black & Gray

Pictured here is a standard RGB and
modified RGB where all the black and
gray data has been removed.

The Layers panel to the right exhibits
two layers and not the usual one.

UltraSeps Sim Process #3 creates
this new pure layer and then
throttles between them to create the
separation benefiting from the
strengths and weaknesses of each.

When removing all grays and blacks from the RGB data, its possible the
range of some colors become extended while others diminished.  This is the
reason both are used during the color separation process of Sim #3.

Upon completion, the Layers Panel will contain both layers named Color and
Layer 0.

If deleting the RGB channels to output films directly from Photoshop CS4 or
lower, the Layers will convert to a single background layer.

Those using Photoshop CS5 (and higher) and printing separations to film
with Illustrator or CorelDraw, I suggest deleting the Color Layer and retain-
ing Layer 0 as the RGB.  This guarantees the image will preview correctly
when using Illustrator, CorelDraw or another application for printing films.



5 Color Separation Original RGB

Pictured here is a 5 color separation
of our cigar smoker using Sim #3
compared to the original RGB.

The full channels panel is displayed
identifying what colors are being
selected.

Since we already discussed most
vital points regarding the adjustment
and modifications of simulated pro-
cess separations earlier within the
Sim Process #1 pages, there’s no
reason to further discuss working
with an UltraSeps Sim Process #3
separation here.

If needing to merge channels, add or
delete data from one channel to
another, modify the base, generate
custom color channels, etc., simply
refer to those pages earlier within
the user guide.

Do not use any of the Auto Reduce Color Actions with these
separations as they are specific to the Simulated #1 output.



Basic 5 Color Simulated Process

General Info Basic 5 Color Sim Process

UltraSeps Basic 5 Color Sim Process makes use of
values within our other simulated process color
functions and generates a very basic color separa-
tion that works for images containing the most
used and popular colors.

Upon completion, this has generated
yellow, blue, aqua, red and black chan-
nels in addition to a highlight white and a
choice of 2 underbase whites.

If additional color channels are needed,
such as a specific color this simple pro-
cess has not provided, especially a
green, use the Custom Color Action of
UltraSeps to pull the needed channel.

See page 33 for instruction on how to
use the Custom Color Action to generate
a channel for a specific color.

Often the blue and aqua channels can be
merged into a single blue channel to
further reduce the number of colors.



Outputting Simulated Process Separations:

Dot Shape - Elliptical

All films 26 Degrees at 55 LPI.

Mesh count 280 - 305 Top Colors.

Mesh count 156 - 230 Underbase White.

Mesh count 200 - 230 Highlight White.

Print Order: Light Colors First - Darks Last (usually).  If the separation includes
a gray ink, run prior to the highlight white.  Run highlight white prior to the
Black.

If the separation includes a channel with a large area of solid ink coverage, run
that at a later point in the separation regardless of color (if possible) to avoid
excess ink buildup.

If problems are encountered such as mesh interference patterns on press,
then output the white base using 50 LPI at 56 degrees.

Manual shops and those doing simpler work may want to experiment with
heavier line screens such as 45 lpi when outputting the film positives and not
to use mesh counts above 280.

Less critical jobs can be effectively printed using 230 mesh for the top colors
with excellent results.



Generate Flesh & Earthtones

The Flesh-Earthtone section of the user guide is quite
extensive.  If you don’t feel like reading it now, just skip
it and refer to when needed.

Sometimes specific inks are needed to image flesh
and earthtones very accurately.  Especially when
the job is primarily focused on those colors and
must look great.  You wouldn’t want to print an
image that’s primarily a human face and not use at
least some actual flesh ink.

We’ve included 4 different methods to pull these
colors, the first 3 are completely automated and called Auto Flesh Earthtone RUN
#1, #2 & #3.  Most files respond well to these and provide excellent results.

The other method guides the user through “picking” a dark, medium and light
flesh.  UltraSeps then makes use of your selection and generates smooth, precise
custom channels.

Below are results of running the automated #1 action.  We also generate a very
basic (not for use on press) black channel within the action to assist in viewing.
The #1 Flesh Action works on files with deep, colorful fleshtones and can produce
great results with little masking required.



Below is the same automated action on a completely different image with nothing
changed or colors adjusted.  Believe-it-or-not, it uses the identical colors from the
previous image.  This time however, we copied our new flesh/earthtone channels
into a simulated process separation.  The ONLY adjustment made was removing
the flesh data within girls body from the red 185 channel which is quite simple
using our Subtract Color Data action or using a mask (discussed in detail later).

This action works best on images containing
flesh / earthtones that have sufficient color
information and is not a good candidate for
washed out whiteish and pinkish fleshtones.

So if not quite right, run the #2 or #3 Ac-
tion or the Custom Action.  Remember, its
okay to change the color of the channels to
better match your image in addition to
bumping them up or down using the Inten-
sify or Fade.

Image Copyright © Jason Patterson



The Auto Flesh #2 and #3 Actions generate flesh and earthtone channels using 2
or 3 colors with inventive calculations to identify all data.  They work for any job
although require a substantial amount of deleting unwanted flesh ink extending
beyond the flesh - earthtone areas.

Above is the output from the Auto Flesh #2 action.  The results are excellent
for only 2 channels and a black for viewing.  These channels can now be Shift-
Dragged into the color separation for inclusion.  Any unwanted ink that may be
found within the jacket for example can be deleted with the use of the eraser tool
or drawing a path and deleting.  We’ll discuss that later.

Auto Flesh Earthtone #2 Output



The Auto Flesh #3 Action:  Below is a completed separation.  Try this one
yourself as its great for getting comfortable with flesh channels.  In fact, Ul-
traSeps has improved upon the color so the print itself will be a bit more at-
tractive than the original.

Original RGB Image Color Separaration

Adjust the channels to more closely match
the original if desired by double-clicking a
channel, bringing up the color picker and
changing its color.

The key to making this excellent separa-
tion possible using the #3 action is creat-
ing a “mask” of the flesh ink areas sur-
rounding the face and arm.

Once the mask is created, which is just a
fancy word for a “path”, all flesh ink out-
side its intended range can be deleted.
Additionally this mask can be used to
remove flesh data within the red channel
and yellow channels.

We’ll get to that after discussing the single
channel flesh action.



The Single Flesh Color Action:  For those requiring the use of fewer colors,
we’ve included an action that generates a single flesh channel while still covering
the entire flesh range so no areas are left without ink.  This action uses a series
of RGB calculations to “grab it all” in one shot.  Most likely, this action will be the
chosen go-to flesh action for many.

When using only one channel to generate all fleshtones, its important to adjust the
color of the flesh channel for the image.  And since we’re only working with one ink,
that should be an easy task.  A few pages later we’ll discuss changing the color of a
flesh channel.

When using only one flesh ink, its a good idea to retain some of the yellow and red
ink data under the single flesh channel to help achieve a wider tonal range.
Be careful with that red as its a flesh killer!
Red is an intense color, the strongest of all and a little too much in the wrong spots
can destroy fleshtones.

Just A Little Reminder:  These actions pull flesh and earthtones only.  The chan-
nels generated must be “added” to the simulated process separation.  This is an
easy process, just select the channel using the Move Tool of Photoshop, hold down
the shift-key and drag it to the destination file (the color separation).  They’ll align
perfectly.



Unfortunately, with all this automation must come a little work!  The most accurate
method to remove flesh ink from outside the boundaries of where its needed is by
making some form of “selection” and deleting it.  This is normally done by drawing a
“Path” surrounding the flesh areas and converting that path into a Channel to allow
easy selection and deletion.

First, open your Path Palette and choose “New Path” from the small arrow in the right
corner.  Next, grab the Pen Tool and start outlining the flesh areas to retain.  More
than one path can be drawn as it will all be saved within the single path named Path 1
here.

Don’t get all stressed out with this.  If a mistake is made while drawing just take the
pen tool, click on the point just placed and hit delete.  You can delete as many points
back as needed.  Points can also be moved (nudged) to better conform to the image
by holding down the CTRL key which converts the Pen into the Direct Selection Tool to
allow moving or adjusting any individual point.

Also noteworthy is once the Path is made into a Channel, if there’s any mistakes they
can be corrected by using the eraser or brush to delete or fill areas.

With simple files, you could select all channels (shift-click each channel) and
simply use the eraser tool with an appropriate size brush to delete unwanted
areas of flesh ink.

Deleting Unwanted Fleshtone Ink



Completed Path

When the path(s) are
complete, CTRL-Click the
path to select it.
(CMD-Click Mac)

Marching ants will immedi-
ately surround the selec-
tion.

Make New Channel

Go back to the channels
palette and choose New
Channel from the upper
right arrow and make
certain “Selected Areas” is
checked.  Don’t worry
about the color or opacity
and click OK.

Note:  The path selection
alone can also be used to
delete with however using
a Channel allows easy
corrections to the selection
if needed.

Fill New Channel

A new channel named
Alpha 1 has been created
with the original selection
still intact.  Now just Fill
with black and we’re ready
to start deleting.



Wow, That Looks Bad!

Here’s our separation
PRIOR to using our newly
created Alpha Channel to
delete excess fleshtones.

CTRL-Click the Alpha Chan-
nel to select it.
(CMD-Click on Mac)

Next choose “INVERSE”
from Photoshop’s Select
Menu.  Doing so targets all
areas “outside” the selec-
tion.

Looking Better!

Simply choose each flesh
channel and hit the delete
key.  All excess ink is now
gone and the flesh chan-
nels are ready to go.  Hit
CTRL-D to deselect the
area.

If the Fill Box appears
when depressing the delete
key, select Fill With White
at 100% Opacity.

Modify The Red Channel

CTRL-Click the Alpha 1
channel again but DO NOT
use INVERSE since we
now want to target the
active flesh area itself.

Pick the Red 185 Channel
and hit delete to remove all
red within the flesh selec-
tion or use a Curve to just
retain a smaller amount of
red within the flesh areas.
Done!  Ready to output
films and print.



When prompted the first color
to select is the darkest &
reddish brown which is usually
the most difficult to select.
Use the Fuzziness Slider to
adjust for more or less of the
color.

The key here is not selecting
too much.  You’ll want to see
some tonal definition within
the color range window as
pictured here and not a dark,
massive blob of ink.  A little
practice goes a long way!

Our “Custom Color Channel”
Action described earlier can
also be used for pulling flesh &
earthtone channels or any
other odd color.

The only difference here is we
provide suggested color values
to the channels (which might
be helpful) and also a non-
printing black channel to help
view the work.

Select Darks

Okay, so you’ve run all the auto flesh
actions and would like to try something
else.  So, lets give our Custom Flesh
Earthtone RUN action a try.

This action prompts the user 3 times to select
a color using Color Range.  UltraSeps will then
run an RGB calculation and generate each
channel.  Its important to pay attention to the
on-screen instruction as to which color to
select and to make certain the “invert box” is
checked.



The next colors on the agenda are the Middle and Light Flesh.  These are easier to
select.  Once again we’re using the Fuzziness Slider to select the proper amount of
color.  When selecting the light flesh, be careful not to contaminate the pure white
areas by selecting too much.

Select Light FleshSelect Middle Flesh

Once completed, three flesh - earthtone channels will be generated along with a non-
printing black to help evaluate the results.  Notice the non-printing black is not accu-
rate and has black data where green should be.  This is normal....as stated previously,
its a “non-printing channel”.

The examples here made use
of faces and human form for
illustration purposes only.

These actions can also be
called upon when attempting
to separate any image that is
earthtone and brown inten-
sive.

Note!  With most art, the Light
Flesh can be merged into the
Middle Flesh so only two chan-
nels are needed for output.

See Adding-Merging Channels
earlier in the user guide.



It might be necessary to adjust the color of a channel to match the image.  To ac-
complish this, double-click on a channel, click on the small Color Chip within the
Spot Channel Options Window. The Color Picker will now appear.  Simply move the
circle within the color picker to modify color.  As its moved, the image will respond
to changes in real-time.  Rename the channel with the appropriate PMS color match
name.

Clicking “Color Libraries” or “Custom” in older versions of Photoshop will launch a
window where an actual PMS number and color can be chosen.   Be aware that
many absolute PMS colors generated within Color Libraries can appear a bit dirty.  If
choosing a PMS color by number, after selecting its advised to open the Color Picker
and mix a pure version of the PMS color so the separation displays correctly.



Although somewhat forgotten by many printers,
true process (CMYK) separations should have a
place in your shop.  They’re easy to deal with
since the same basic set of inks are used on all
jobs in addition to being very small press friendly.

The major downside to process color is limitation
to white and lighter pastel shirts.  Darks can be
difficult to achieve a bright, vibrant image on and
are better left to those who specialize in doing so.

All CMYK separations MUST start with an RGB file configured for UltraSeps.  Do not
use an existing CMYK file!   Also avoid using files saved as CMYK and reverted back
to RGB if possible.

We recommend a white underbase at all times when printing CMYK, including white
shirts as this helps control ink deposit and always provides a better looking print.
Since process inks are transparent, not using a base will always result in faded
images after a few washings due to fabric fibrillation which is t-shirt fibers penetrat-
ing the thin, transparent layer of ink.

Process color works best with busy photographic style images, soft pastel graphics,
animals, people, paintings, etc.  We don’t recommend CMYK on art with large solid
areas of a specific color(s), especially if the integrity of that hard color is vital.

As with all files processed with UltraSeps, make certain the art is bright and colorful
prior to running the CMYK action.  If in doubt, run Ultra Image Fix and/or Brighten
Define Image on a copy of the original and compare.  Or just experiment with a
curve, bumping up saturation, etc. to improve the art.

Since UltraSeps will convert the composite CMYK to multichannel, establishes the
RGB channels again and has made radical adjustments to help the image print
correctly, it might appear slightly off and dull on screen.  This is normal, so just trust
the separation.

Remember, CMYK separations for screen printing are quite different from those used
in offset paper printing.  By only converting to CMYK in Photoshop, doing nothing
else to the image and then outputting films, the first few shirts might look okay,
although a few shirts later its a complete disaster.

Process printing is fairly straightforward and you’ll simply output the films and go.
About the only adjustment required with some art is either lightening or intensifying
the Magenta Channel with a simple Curve.  Therefore we won’t spend too much time
on it here aside from an example of separating a file for process printing (sample file
is included with UltraSeps).  We’ll also review the Actions that add spot colors to a
CMYK separation and how to adjust the separation to make use of a spot channel.

Process Color CMYK Separations



An image like this is ideal for CMYK
process color.  Its extremely busy
with many soft blended pastel
shades and no absolute reference
colors, such as a company logo.

Plus if any slight color shift occurs
during the run which is common with
process, its probably not an issue.

Screenshot of orignal
RGB file shown at right.

Below is the finished process separation.  Notice its slightly faded and muted when
compared to the RGB file above.  This is normal.  If the separation closely matched
the original, it would print dark, muddy and be impossible to control.

The process has generated 2 highlight whites.  The channel named “Dark Highlight
White” helps in muting problematic images on press and has the most impact on the
Magenta Channel.  This darker highlight is helpful when printing process jobs that
are flesh intensive as it takes the intensity off the Magenta in key tonal ranges.

Although a CMYK
separation, the RGB
Channels have been
retained.

These are needed if
any additional spot
channels are gener-
ated.

When printing pro-
cess color, always
run the job Y-M-C-K.

See output settings
for further info.



Certain colors are not produced well by pure CMYK
and a custom spot channel may be needed. This
might be a specific PMS color a client requires,
neon’s, metallic’s, or a large area of a solid color
such as big solid text.

The Add Spot Color Action solves this problem by
allowing the end user to select a specific color from
the RGB Channels to generate a custom spot color.

Add Spot Color To CMYK Separation

This old movie poster art is another good
candidate for process color.  Its also ideal to
demonstrate using the Add Spot Color To
CMYK Action.  Although this would print okay
without a spot color, the appearance would be
enhanced by using a spot color for the solid
red within the large text and badge.

After clicking the Add Spot Color Action, Color
Range opens.  Make sure “Invert” is checked
then using the eyedropper, select the spot
color along with using the Fuzziness to control
the amount of color selected.

When satisfied, click OK.  A perfect spot color
channel named CMYK Spot Channel is then
generated using the color selected from the
image.



Pictured is the CMYK sepa-
ration with new spot chan-
nel added.

What needs to be done
now to assure the art
prints cleanly is to remove
some of the spot channel
data from the C-M-Y chan-
nels.

Not doing so will retain
excessive process inks
under the spot color which
can result in a muddy spot
color on press.

Before and after of the Yellow process
channel following the Remove Spot
From C-M-Y Action.

50% of the spot color data has been
removed from the Yellow, Cyan and
Magenta channels.

The Action didn’t remove it all since
doing so could adversely affect some
images on press.  Although if your
spot color is an absolute solid such as
this, the Action can be run twice to
remove the spot channel data further
from the process colors.

After removal of the spot color data
from the C-M-Y channels the sepa-
ration will appear more natural and
the spot color itself not as strong.  If
the spot channel needs it, run the
Darken CMYK Spot Channel Action.

Always run the spot channel
after the C-M-Y channels and
prior to the Black!



Outputting CMYK Separations:

Dot Shape - Elliptical

All films 22.5 Degrees at 55 or 60 LPI.  (26 degrees works also)

Mesh count 305 - 330  Top Colors.

Mesh count 200 - 230 Underbase White.

Mesh count 230 - Highlight White.

Print Order: White Base - Yellow - Magenta - Cyan - Highlight - Black

You can also try printing the White Highlight last.

If using a Spot Color, always run that prior to the Black.

For those having difficulty controlling an image, the dark highlight may help.

The process separations are normally quite accurate.  If for any reason the
image appears dark, your process inks are most likely too strong.  Switch to
less potent inks or add clear extender base to the yellow, magenta and cyan.

Tip:  If your Magenta and Cyan process inks appear more like burgundy and
navy blue in the bucket, the inks are too strong.

Only use high pigment content process colors if attempting to run process jobs
on darker shirts.



This is one of my favorite types of sepa-
rations and I’ve done many designs using
it.  Show a sample job to your client and I
bet they’ll love it!

Although we’re separating a grayscale
image, UltraSeps actually generates the
separation using RGB data.

The Grayscale Separation Action works on
both full-color or grayscale images.

If the art is already in Grayscale mode,
convert it to RGB mode.  Although this
isn’t absolutely necessary, its a good idea
just to make sure all runs smoothly.

Below is the original file (included with UltraSeps) and the finished separation using
an underbase, 3 grays, a highlight white and black.  The action also pulls a dark
highlight as an option.

The number of colors required in most grayscale separations can be reduced
by merging the Cool Gray #3 Channel with the darker Cool Gray #6 Channel.

Grayscale Separations



Here’s a view of the finished grayscale
separation with each channel generated
illustrated separately.  These seps are
normally ready to go once the action
stops and require little to no adjust-
ment.

Some files may print better by
substituting an extremely dark
(almost black) dark charcoal gray
ink as opposed to using a black ink.

To decide if a file responds well to this,
double-click the black channel then
click the black color chip within the
Spot Color Options Box to bring up the
color picker.  Now experiment with
changing the black channel to an al-
most-black very dark gray.

Not all grayscale separations require
the inclusion of a highlight white.



Outputting Grayscale Separations:

Dot Shape - Elliptical

All films 26 Degrees at 55 LPI.

Mesh count 280 - 305 Top Colors.

Mesh count 156 - 230 Underbase White.

Mesh count 200 - 230 Highlight White.

Print Order: As specified on channels palette.

If problems are encountered such as mesh interference patterns on press,
then output the white base using 50 LPI at 56 degrees.

Grayscale separations are more tolerant to lower mesh counts such as 230 for
top colors using a lower line screen such as 45 - 50 LPI.



Specialty Separations

Specialty Separations are a set of  actions that
provide a completely different look to your art.

They’re great for use with preprint lines or to
offer your customer something beyond the
ordinary.

They work with any color RGB or grayscale
image.

Blue Quad-Tone Green Quad-Tone Gold Quad-Tone

Red Tri-Tone Sepia Tone



General Guidelines On Specialty Separations:

These novelty style Actions run the same as any UltraSeps color separation
and require very little (if any) adjustment upon completion.

They work on any color RGB or grayscale file.

The “Quad-Tone” Blue, Green and Gold Actions generate separations contain-
ing 4 top colors, an underbase, and 2 highlight channels. We highly recom-
mend using the “Primary Highlight Channel” with most jobs.

Usually, separations can be reduced to 3 top colors by merging two of the
first three channels into one. Experiment for best results with a given image.
This results in a 5 color job containing an underbase, highlight and 3 top
colors.

Using the heavier Primary Highlight White is required to maintain proper
color balance and tonal transition on press. Very few jobs can be effectively
printed without it. Intensify further using a Curve if needed.

The underbase generated is slightly different and heavier within certain
areas when compared to other UltraSeps bases. This is due to white ink
being required under the darkest top color to retain a bright image on press.

If printing on non-darks and using the underbase (highly recommended), its
okay but not absolutely required to lessen its density by selecting the under-
base channel and lighten using Photoshop’s Curves function.

The Tri-Tone Red is similar to the Quad-Tone separations with the exception
of using only 3 top colors by default.

Sepia Tone Separations are a tri-tone that includes 3 top colors, an under-
base, and 2 highlight channels. We highly recommend using the “Primary
Highlight Channel” with Sepia Tone.

Attempting to further reduce the number of top colors within a sepia tone
separation may produce unacceptable results.

PMS colors referenced are a general guideline. An exact match is not re-
quired although they should be somewhat close. The most vital criteria is
to make certain that no 2 colors are very similar as image definition
will suffer greatly.

At the end of the separation process, the Action will suggest an
alternative PMS color value via a message box to replace the darkest
color in the separation if further contrast is needed or desired.



With most art, great results on press can still be achieved by merging or deleting
one channel and this is almost always the lightest color channel.  Above we simply
deleted the Powder Blue Channel in the center image.  On the right we merged
50% of it with the Light Blue 306 Channel.   All three will print well.  When merging
the lightest channel, its sometimes advisable to increase the density of the highlight
channel “slightly” to assist with retaining contrast.

Original Separation
25% Powder Pink

Merged With Red 1787

With the image on the right,
we merged 25% of the Pow-
der Pink 182 Channel with
the Red 1787.

We also bumped the Primary
Highlight White Channel
slightly to help retain some
lost detail.

The adjustment results in an
easy to print 4 color separa-
tion containing two reds, a
base and highlight.

Examples Of Merging Channels With Specialty Separations

Original Separation Without Powder Blue Powder Blue Merged
With Light Blue



Outputting Specialty Separations:

Dot Shape - Elliptical

All films 26 Degrees at 55 LPI.

Mesh count 280 - 305 Top Colors.

Mesh count 156 - 230 Underbase White.

Mesh count 200 - 230 Highlight White.

Print Order: As specified on channels panel.

Its imperative to follow our ink print order guidelines when printing
specialty separations.

If problems are encountered such as mesh interference patterns on press,
then output the white base using 50 LPI at 56 degrees.



Index Separations don’t use traditional halftones.
They are composed of square pixels of a given size
determined by the image resolution.

All images to be separated as Index need to be in
RGB format at 150 to 200 dpi.  Resolutions below
150 dpi generate a slight grainy effect and are
normally undesired although can look good with
the right art.

Do NOT use files above 200 dpi!  Doing so
generates a bitmap pixel which is too small to be
held by the mesh.

The original MUST begin at final output size.  Remember, Index Separations can not
be up or downsized when complete.  When outputting the film, screen frequency or
angles are not required as Index Files are a bitmap and not halftones.

Although Indexing has been associated with high-end designs printed in 10 or more
colors, you might be surprised how well a 4 or 5 color job prints.

The Automated Actions provided do an excellent job and generate separations using
4, 5, 6, 7 or 8 top colors in addition to underbase and highlight whites.

Usually its preferable to select colors actually used within the image when
doing Index, so we’ve also provided Actions that generate user-defined
index separations.

Both the automated and custom Index Actions generate traditional Halftone Under-
base and Highlight White Channels in addition to Indexed Channels.  Many printers
will notice higher quality results along with a softer hand when combining Index top
colors with a halftone base and halftone highlight.

Index seps can offer a fresh, different new look to your work and are very easy to
print.  Just don't run one of the automated Actions and go with it.  Experiment with
both the Automated and Custom Index Actions.

We’ll review an automated 5 color Index and a Cus-
tom Index Separation using the graphic at left which
is included with UltraSeps.

Indexing with UltraSeps prompts the user several
times during the process to assure certain critical
settings are correct while the calculations are running.

Aside from that, once completed the separation is
press ready as index files can’t be adjusted using
curves, levels, etc. since they are bitmaps.

Index Separations



A short while after initiating
any of the Automated Index
Actions you’ll be presented
with the following message:

After clicking Continue, the Bitmap Box
will open and here is where a few
settings must be verified.  The original
resolution of the file is shown as the
Input, in our sample here its 175 dpi.

Make certain Output Resolution is
identical. If not, change it. You must
also make sure “Diffusion Dither” is
selected. Now click okay.

You’ll be prompted again twice to
verify these settings.

If an index separation was never at-
tempted with the installed version of
Photoshop, most likely the the “Discard
Other Channels” warning will appear.

Check “Don’t Show Again” and click
OK.



When all on-screen
activity stops the sepa-
ration is complete.  To
get a detailed look at
the file, turn on all top
colors, the indexed
underbase, light high-
light channel and zoom
in.

Unlike viewing a simu-
lated process or cmyk
separation which ren-
der as a smooth, con-
tinuous tone image on
screen, with Index
you’re actually viewing
the “dots” themselves.

This sample clearly shows at an
extreme zoom the makeup of an
index separation which is basically
small squares that sit next to each
other.  Index files actually print
very smooth and clean so don’t
get concerned when zooming in
on screen.

Also, don’t stress too much re-
garding ultra-precise registration.
Although the bitmap “squares” sit
next to each other and never mix
or overprint like a traditional
separation, the on-press behavior
of an index separation is quite
forgiving.  After a few prints the
colors will begin to gel together.



A view of the channels panel following a 5 color automated Index run which
generates 5 top colors plus whites.  Much thought has gone into selecting the
color palettes the Index Actions utilize and for many jobs they should work well.
If there’s any doubt the color palette of an automated index doesn’t work with
your art, run a Custom Index separation.   (We’ll discuss that in detail next)

When printing Index, its sometimes advisable to not print the black last.  If your
designs are not printing as well as expected, try running the black one or two
stations earlier.

Since Index separations can’t be adjusted or resized, the file is now ready for
film output.  The only decision here is deciding upon what underbase and high-
light channel (if any) are needed.

Although Index does not require a line screen, angle or dot shape to be
selected at time of output, if deciding to use the traditional halftone base
and highlight, those channels do!  See the Index film output page at the
end of this section for instructions.



For absolute control and accuracy of your Index separation or if your art includes
odd or absolute colors which must be matched such as corporate logos, etc. then
run our Custom Index Action that guides the end user through selecting all top
colors within the design.

The custom index action is actually a set of two.  The first action being a script
which generates the base and highlight whites and then prompts the user to
select the colors within the design.  The number of colors selected is entirely up
to you.

The second is a short action which generates the user selected index top color
channels and must be repeated for every color chosen.  The entire process
shouldn’t take more than 5 minutes to complete.

Follow the simple on-screen message
box instructions.

When the Indexed Color Box appears,
make sure to uncheck "Preview"
first!

Then choose a Palette of "Custom".
Now make certain your settings match
our example here.  Click OK.

Preview Unchecked (Do This First)
Palette: Custom
Matte: None
Dither: Diffusion
Amount: 75%
Uncheck Preserve Exact Colors

After clicking the Custom Index #1 Action, you’ll
be presented with the same dialog as when run-
ning Automated Index.  Make certain at each
prompt the Input / Output Resolution is identical.
If not, change it. Also make sure “Diffusion Dither”
is selected.  You’ll be prompted again twice to
verify these settings.

Macintosh CS3 & CS5 Index Bug!  These versions of Adobe Photoshop
running on Macintosh have a bug which prevents colors from being se-
lected when using the Color Table.  We have found a solution to the prob-
lem.  See the Mac Index Bug on page 89 for complete information to
resolve the issue.

Custom Index Separations



When the Color Table appears,
every cube will be filled with
white.  Next, click the first white
cube in the upper left corner.

When the Color Picker appears,
zoom in on the art and use the
eyedropper to select a color.  In the
example we’ve selected a blue.  If
the color is not critical such as a
pms match, I suggest moving the
circle around within the color picker
to choose the most “pure” version
of the color in question.

Here we wanted a bright blue al-
though getting a “pure” sample with
the eyedropper is almost impos-
sible.  Choosing clean, pure colors is
vital for a bright and eye pleasing
index separation.

Once satisfied with the color selec-
tion, click OK.

Repeat this process for each color desired and
when satisfied, click OK in the Color Table
Window.  In our example here, we’ve selected
a blue, slightly orangey red, yellow and black.
When selecting the black, make sure to set it as
absolute black!  Move the circle within the
Select Color Window to the lower left corner
until the Black reads all zero’s as its RGB value.

Tip:  Stay away from selecting deep scarlet
reds and choose a more orangey red as this
provides a brighter image and smoother blend-
ing with the yellows.  With blues, yellows,
greens, magentas (the vital colors), remember
to pick ”Pure-Bright-Clean Colors”!



When the Color Range window
appears make sure Invert is
checked.

Use the eyedropper to select
one of the colors within the
image.

Move the Fuzziness Slider ac-
cordingly to select the data and
click OK.

A Spot Channel using the se-
lected color is automatically
created within the Channels
Panel named Spot Color 1.

Repeat this Action with all colors
in the design.  Upon completion
your channels panel will contain
every user selected color and
the multiple white base and
highlight channels to choose
from.

The composite Index Channel
can now be deleted.

At this point you’ll be presented with a channels
panel containing a composite Index Channel along
with Index and traditional underbase and highlight
channels.

The Index channel will look distorted and grainy
although this is normal, the final separation will look
fine.  Just zoom in to get a clear view.

Now make sure the only channel selected and visible
is the Index Channel and run the
Custom Index #2 RUN Action.



Below is our custom index separation which only took a few minutes and is
quite accurate while using very few colors.  In our sample here we renamed
the Spot Color 1,2,3,4 Channels Yellow, Blue, Red, Black to indicate their
actual colors.

Most users will rename the custom channels using PMS numbers to avoid
confusion at press.  We also arranged the channels for correct viewing.  Just
decide which underbase and highlight to use, output the films and go to
press.  No further adjustments are either necessary or possible.

I encourage those new to index separations to experiment using the same
file shown here.  Its included with UltraSeps.

Indexing is actually quite simple and after a few separations you’ll be
doing these custom index jobs in minutes.  Watch the demonstration
video since the procedure is easier to get comfortable with by viewing as
opposed to reading.



Adobe Photoshop, “Macintosh Only” versions CS3 and CS5 have a bug which
makes it impossible to select colors within an image when using the Color Table
during the index color selection process.  Clicking within the image using the Eye-
dropper while using the Color Table results in no color selection.

If using either of these Photoshop versions on a Macintosh, just follow our below
solutions to work around the issue.

Index Color Bug - Macintosh - Photoshop CS3 & CS5 Only

CS5 Index Fix

When using Photoshop CS5,
follow the instructions within this
user guide on picking custom
colors for your index separation
BUT, prior to clicking within the
image to select a color, move the
“slider” upwards (circled in
green) in the Select Color win-
dow.

After moving it, place the Eye-
dropper within the image to
select a custom color.  If this
slider isn’t nudged first, the
Eyedropper tool will not sample
colors from the image.

Repeat prior to selecting all addi-
tional colors.

CS3 Index Fix

When using Photoshop CS3, follow the instructions within this user guide on picking
custom colors for your index separation but when the Select Color Window opens,
hold down the Shift Key and click “anywhere” within the image.  Now release the
Shift Key and click with the Eyedropper to select your custom color.

If this sequence isn’t followed, the Eyedropper tool will not sample colors from the
image.  Repeat prior to selecting all additional colors.

The above sounds more confusing than it is, just follow our instructions
carefully.  If you’re upset about it, please contact Adobe.  The error is
not due to UltraSeps and is strictly a Photoshop issue.  It exists if using
UltraSeps or not.



Outputting Index Separations:

Do not attempt to resize the image once separated!

No Frequency, Screen Angles or Dot Shape Required.

Mesh count: 305 All Top Colors.  280 can be used on files 175 dpi or lower.

Mesh count: 156 - 230 Underbase White.

Mesh count: 200 - 230 Highlight White.

Print Order: As specified on channels panel when using Auto Index.
Usually light to dark when running Custom Index.

Index Separations With Halftone White Base & Highlight Channels Only
(If Used):

(Settings For Halftone Underbase & Highlight Only)

Dot Shape - Elliptical

Both Underbase & Highlight should be 26 Degrees at 50 LPI.

Mesh count 156 - 230 Underbase White.

Mesh count 200 - 230 Highlight White.



Since UltraSeps can’t obviously “see” what hard spot colors are contained within
your art, it asks the user to select each color using Color Range.  After clicking the
Basic Spot Color RUN Action, you’ll be presented with the below message:

Basic Spot Color Separations

The file at left is an excellent example of basic
spot color as it represents 4 solid colors with
no tints or gradients.  The Actions will gener-
ate a perfect user defined color separation
from images such as this.

These Actions are primarily for art con-
taining very little or no tinting or blends!
It fills the selection with 100% color and does
not run an RGB calculation like the Custom
Color Action within the Simulated Process
group of Actions.

If your spot color art contains tints or
gradients, then try running one of the
Simulated Process Actions or use the
Custom Color RUN Action to select your
spot channels.

Although basic spot color separations are usually
done with Illustration programs, often you’ll need
to do them within Photoshop.  Maybe you’ve re-
ceived a basic file that’s not saved as a vector
image or for some reason, (and there’s many) the
file is proving difficult to work with using Illustrator,
CorelDraw, etc.  For these times Photoshop is the
answer.

The Spot Color Actions make doing them a breeze
and have been further simplified in UltraSeps.



When Color Range opens, select
the first color within the design
using the Eyedropper and adjust
the Fuzziness for more or less of
the color.

Make certain Invert is
checked!

Once satisfied with the selection
click OK.

A completed spot color
separation.  UltraSeps will
name each spot channel
generated Spot Color
1,2,3,4, etc.  These should
be renamed to reflect
their actual color.

A new spot channel is
automatically generated
using the selected color
and named
Spot Channel 1.

Repeat the process for
each spot color within
the image.



If running on darks, you’ll obviously need an underbase.
If so, open a copy of the original image and use the
“Basic Spot Underbase RUN” action.

Upon completion you’ll have a new file with only 1 chan-
nel containing the underbase.  Select that channel and
“Shift-Drag” it to the window of the color separation
using Photoshop’s Move Tool.  (Shift-Dragging aligns it
perfectly with the other file).

Note:  Do not change the name of the underbase
channel yet since UltraSeps may need to modify it.

We Shift-Dragged the
white base channel to the
separation and placed it
above the top spot colors.

Also changed were the
generic names of the spot
channels to reflect the
actual colors.

If this image were to be printed on black or another dark color, white ink would
be needed under the navy blue ink.
To accomplish this do the following:

1.) Click the Add Color Data To Base RUN Action

2.) When prompted CTRL-Click the Navy Channel

3.) Click the Action Button again (Now Highlighted Red)



Before and After adding the navy channel data to the white base.

If any white ink is “peeking” from behind the colors, a small “Choke” of the
underbase is probably needed.  See Choking The White Underbase covered
previously.  To view a basic spot color separation against a dark background,
use the “Add Shirt Background Color Action” to generate a solid channel filled
with black and position it as the top channel.

With hard spot color, a very small gap between colors is sometimes unavoidable
when generating the separation.  If you think the gap could be an issue on-press, a
small trap is then needed on some or all colors (except black).  UltraSeps includes
an action named “Trap Spot Colors RUN” to assist in closing these gaps.

Select a spot channel to be trapped and run the action.  Repeat for each spot chan-
nel needing a trap.

An extreme close-up view before
and after trapping the spot chan-
nels.

This file required trapping the Gold
and Light Blue channels.  The
Navy did not require it.

Once again, avoid trapping the
Black as this adds noticeable line
weight to the image.  Only trap
the Black if absolutely necessary.



Outputting Basic Spot Color Separations:

Dot Shape (If Needed) - Elliptical

All films (Absolutely No Tints or Gradients) 26 Degrees at 300 LPI .

All films (With Moderate Tints or Gradients)26 Degrees at 45 LPI .

Mesh count 156 - 200 (designs using no white base).

Mesh count 200- 305 Top Colors (designs with a white base).

Mesh count 156 - 200 Underbase White.

Print Order: Light to Dark.

Note:  Using 300 LPI to output solid color channels helps to keep lines and edges
sharp.

HELP!  My basic spot channels are filled with solid black as
opposed to the selected area and color.

The reason is that Photoshop has somehow reverted to using Masked
Areas as opposed to Selected Areas to generate the channel.

To fix, go to the Channels Panel and click the downward facing arrow in
the upper right corner of the palette and select “New Channel”.

When the New Channel window opens, click the “Selected Areas” button
and then click OK.

Photoshop is now set to use Selected Areas.



QuikDraw

QuikDraw is a set of 5 actions that convert any
photograph or continuous-tone image into pure
black & white art printable using 1 screen.  The
original art should be at 200 dpi minimum.
QuikDraw will increases the resolution to 300 dpi so
if the final QuikDraw output needs to match in size
with the original, start with an image already at 300
dpi.

If the image is a small left chest graphic, run QuikDraw on an oversize file if possible
then reduce the size following conversion for best results.

We suggest trying all 5 QuikDraw actions then decide which looks best.
Images that convert well using QuikDraw begin with excellent definition and clarity.
If results are unsatisfactory, consider running Ultra Image Fix first, then attempt
QuikDraw again.

An interesting effect is using the output from QuikDraw and applying it to an RGB
color file.  What this does is give the photo a hand-stippled cartoon effect.  The
original must be 300 dpi (exactly) to experiment with this.

A few samples of running QuikDraw.

Unlike 1-4, The QuikDraw #5 Action is
adjustable and prompts the user to
set the level of conversion.

Output QuikDraw files at 300 LPI
to retain sharpness and edge
definition.



Here’s something interesting to try.  After running
QuikDraw 2 on an RGB image, we then Shift-Dragged
the QuikDraw Layer into the original RGB file and set the
Layer Blending Mode to “Overlay”.  Following that I
selected the color image layer and bumped it up slightly
using Curves and also increased the saturation.

Using QuikDraw To Create A Coloring Book Style Effect

The final effect is a hard-edge coloring book style graphic.  The layers would
then be merged, (merge visible) into one layer named “Layer 0”.  UltraSeps
Simulated Process or an Index Separation could then separate the file.

The original image MUST start out at 300 dpi for this to work.

If not, the Layers won’t align correctly since QuikDraw upsamples all
images to 300 dpi.

When outputting a black and white QuikDraw file to film, use the fol-
lowing settings:   300 LPI at 45 Degrees. Since no halftones are
needed, the high LPI guarantees the sharpest film image.



Ultra Cartoon Effect

UltraSeps includes a script which converts an image
into a cartoon style effect.  The Action works on a
duplicate of the original and generates three differ-
ent layers, each with a different look.  Just select the
desired layer and discard the others.

The three layers generated are named Cartoon Rough,
Cartoon Detailed and Cartoon Stippled.  Since this is an
RGB file, use any of Photoshop’s tools such as Curves, Hue
Saturation, Levels, Selective Color, etc., to modify.  The file
can then be separated for t-shirts or used for any other
purpose.

Ultra Cartoon works best on colorful, clearly defined, high resolution files.  Its
great for things such as cars, trucks and art with excellent contrast, color and
harder edges.  Basically, if your image is bland with little contrast or an out-of-
focus mess, don’t expect too much!  If the end result needs help, try improving
your art “prior to conversion” by enhancing the color, sharpening, etc.  Some
artwork may also benefit from using Photoshop’s Unsharp Mask filter following
conversion.



UltraSketch

UltraSketch is quite unlike QuikDraw as it attemps
to produce a lighter drawing of an image and
omits most of the darker colors.  This usually
results results in a pen and ink type effect without
all the solid fills.

UltraSketch only responds well to higher resolution, clean files that contain suffi-
cient detail.  Low resolution, poor quality art should be avoided along with “wishy-
washy” pastel style graphics.  Quality images that are isolated from their back-
grounds work exceedingly well.  (As pictured above)

The Action generates two Layers named Soft Sketch and Hard Sketch.  Just select
the one that better suits your art.  In addition to outputting the sketch and using
“as is”, there’s many creative uses for these.  One example is to “custom paint”
the sketch!  This is done by adding a new Layer under the Sketch Layer and then
changing the “Blending Mode” of the Sketch Layer to “Multiply”.  Then choose the
new layer created underneath and paint within it to colorize the sketch.  The video
also demonstrates how to easily change the color of the sketch itself to red, blue,
purple or anything which is great for direct to garment printing.



Distress Image

UltraSeps includes an inventive distress - vintage
image action.  No only is it very simple to use but its
also quite unique since it allows the distress effect to
be adjusted, removed and turned on or off.  Plus,
with the use of QuikDraw you can search the internet
for any kind of textured image such as stone, bricks,
gravel, wood, or whatever and make your own dis-
tress patterns in seconds!

After clicking the Distress Action,
you’ll be prompted to place a
distress filter.

Locate the Distress Textures
folder included with UltraSeps,
select a filter file and click Place.

Once the distress filter file has been
placed, drag the handles to cover your
graphic completely.

It may be required to drag both the
horizontal and vertical handles to cover
the image.



When the art appears as pictured here on the left, with
the distress texture covering it entirely, hit the enter key
to complete the process.

To try another filter, go to
Photoshop’s History Panel
and click the image at top.
This will revert the file back
to its original state and per-
mit the distress action to run
again using another filter.

To turn the distress effect on or off, Shift-Click the
Layer Mask (circled).  To modify the distress ef-
fect, click on the Layer Mask and use virtually any
Photoshop Tool such as Levels, Curves, Rubber
Stamp, Eraser, etc. to make changes to or inten-
sify / fade the effect.

To make the distress effect permanent, drag
the Layer Mask into the trash of the layers
panel and click “Apply” when prompted.  The
“Color” layer can also be deleted.

The result of running the Scratchy Grunge Filter.

Click on the Layer
Mask and use a
Curve to adjust it!



The file can now be separated using whatever method desired.  Remember this
technique is also great for simple 1 color graphics.  Our distress image action
can be used with distress textures you may already own.  All that’s required is to
save them as PDF or JPEG Files at 300 dpi.

UltraSeps users can easily make their own distress filters with the help of
QuikDraw.  Just about any texture can be used and many free textures can be
found by searching the internet.

Below are examples of running QuikDraw 2 on a few color textures.  QuikDraw
converted them to black and white art at 300 dpi.  Now save in PDF or JPEG
Format and you’re ready to go!  Just add your newly created custom textures to
the UltraSeps Distress Textures Folder for easy access.

Making You Own Distress Filters



UltraSeps contains a simple action that generates a
single layer RGB file from your multichannel sepa-
ration (simulated, grayscale, index, process, etc.)
to output on a color inkjet.  This comes in handy as
it better represents how the separation will print in
most cases.

The Action is completely automated, one-click and
the prooof is generated.  If your separation still has
the RGB channels, click the Delete RGB Channels
action first!

Generate Composite Proof

Separation as it should
appear prior to running
proof.  Notice (No RGB’s)

If the job is to be printed
on darks, include the shirt
background channel.

Sample here is a 5 top
color, 2 Whites separation
using the Sim #2 Action.

Finished Color Proof and the appearance of the Channels Panel.
All spot channels have been merged into a composite RGB image.

Output color proof to any inkjet printer or saved as a jpeg
to email customer for approval.



This is a silly little action that might be somewhat
entertaining as it allows the viewing of the color
proof on-screen as a halftone.

The action duplicates the target file, applies a
halftone screen and increases the resolution to
enhance the preview.  Once complete, which takes
from 5 to 30 seconds depending on computer
speed and file size, simply zoom in until the half-
tone becomes visible and clear.  Do not use on
index separations!

Preview Halftone Screen

Low resolution screen shot here may not appear accurate.



Custom Register Marks

These Actions generate registration marks to
avoid using the small default register marks at
output. Most printers dislike the default register
mark clusters used by Photoshop, Illustrator or
CorelDraw as they’re engineered offset print-
ing.

This action are used after the color separation
is complete.  If a file still contains the compos-
ite RGB, CMYK or Index Channels, they should
be deleted prior to running the desired Action.

The Canvas Size (Not Image Size) of the file might need to be increased to
make room for the register marks if the artwork extends to the top and bot-
tom of canvas.

The Actions automatically adjust the size of the canvas to allow room for the
register marks.  If after running you feel additional room between the marks
and the image is needed, go to the History Panel of Photoshop and click the
file name at the top.  This reverts the file to its original state.

At this point increase the “Canvas Size” of the document and run the register
marks action again.

All Actions place both corner and center marks on each channel of the sepa-
ration.  The entire process is automated, no end user channel selection is
required.  Just click the button and its done.

The smaller Registration Mark Actions of .50 or less do not function correctly
on files with resolutions less than 200 dpi.

Your choice of 8 different sizes of register marks are available.

For those without a RIP and using UltraSeps to convert the sepa-
ration to halftones, run the registration marks action AFTER con-
verting the separation to halftones!

If the marks are placed before the halftone conversion, halftones
will also be applied to the register marks thus making them
choppy and possibly unusable.



And that’s it, the process is complete, precise and easy.  Accurate corner
and center registration marks have been added to each channel.

Note, the registration marks generated are resolution independent.  A .75
mark will be .75 at 200 dpi, 250 dpi, 300 dpi, etc.  The resolution of the art
will not change the physical dimensions of the register marks.  Its also
important to note that since the marks are “part of the separation”, higher
resolution files (300 dpi) will provide optimum results.

When outputting the films within Photoshop or from another application, its
no longer required to check “add register marks” since larger, easier to view
register marks have been applied.  About the only addition at output is to
check Labels so each channel is labeled with its color.

If additional channels named Cyan, Magenta and Yellow are in-
cluded upon completion of the process, this indicates the RGB Chan-
nels were not removed prior to running.  If so, delete them.

The result of clicking the .62 Register Marks Action.

These actions work on your original separation, not a duplicate.  If not
working on a duplicate and the marks need to be removed, go to the
History Panel of Photoshop and click the file name at the top.
This reverts the file to its original state.



Output Halftones No RIP

For those without a RIP,  this method does a
good job of applying a halftone screen within
Photoshop for film output.

It’s also a great safety net in the event of soft-
ware problems or a new printer not being com-
patible with your software RIP.

By no means are these intended to replace the
use of an actual software RIP program.

General Guidelines:

Once satisfied with the color separation, delete the RGB and shirt background
channels leaving only the color channels required for film output and “SAVE IT”.

A color separation with a maximum of 10 colors can be processed. The speed, age
and condition of your computer has a great effect on how slowly or quickly the
conversion process runs which can take as long as 3 minutes or as quickly as 30
seconds.

Even if your separation is only 2, 3 or 4 colors, these functions will assume the file
contains 10 colors and cycle through. Once complete however, the channels panel
will only contain the intended number of colors with no additional channels.

Do not attempt to resize the document following conversion as it will
result in unacceptable output quality. Make sure the separation is the
correct final dimensions prior to running the convert to halftone action!

To get an idea of how the image will actually print, zoom “out” on screen with all
channels visible (make it smaller) to the first magnification level that appears
normal.

The resulting output is a multichannel bitmap file with an integrated screen angle,
LPI and dot shape applied to all channels. Do not attempt to set any screen
angles or LPI settings prior to output. Just print out each channel to film
using default settings.

All converted channels retain their original color, names, etc. to allow normal
preview and output. The final converted image is a single multichannel file with all
color data and channel names intact.

Channels can not be adjusted (darkened - lightened) once converted to halftones.

If additional new channels named Cyan, Magenta and Yellow are included once the
process is complete, this indicates the RGB Channels were not removed prior to
running.  Simply delete them.



Image Prior To Halftone Conversion

The sample shown is how the separation
must appear prior to halftone conversion.

The RGB channels have been deleted along
with the Shirt Background channel.  The
only channels remaining are those needed
for film output,

This Area Intentionally Left Blank



Once all on-screen activity
stops and the contents of
the channels panel displays
only the colors in the sepa-
ration, the process is com-
plete.

The converted file has been
named “Source” which can
be changed by the end
user.

No RGB channels are re-
quired since this type of
separation can be printed
directly from any version of
Photoshop using the default
output settings.

Converted File - Each Channel Is Now A Halftone

Magnified portion of
Black Channel to
reveal halftone
conversion.

At this point, custom register marks can be added to the converted
separation prior to output.

The converted separation above is a multichannel file with color information and
channel color names intact.

Its worth repeating that since each channel is now a bitmap, any adjustments such
as Curves or Levels have no effect.  And since its a bitmap with embedded at-
tributes such as line screen, angle, etc., it can not be resized.  The resolution has
also been increased to 600 dpi.

Using the above converted 50 LPI halftone as an example, we zoomed “out” to
8.33% or 12.5% to get an idea how the file will perform on press.

Higher magnification previews, 25%, 50%, etc., will render a preview that’s far too
light due to many reasons.  In fact, zooming in will lead most to believe there’s not
enough ink within the channels and that dots are going to print exactly on top of
other dots when this is simply not the case.



Printing A Separation Converted To Halftones Using Photoshop
Older Photoshop Versions  •  CS1-CS2-CS3-CS4-CS5

When outputting to film, do not attempt to specify a frequency, screen
angle or dot shape as that information is already embedded within the file.
Just output as you would line artwork at default printer resolution.

When printing the separations from Photoshop, make sure
all channels are turned on with the “Eye” visible next to
each.

Next choose Print
(or in Photoshop versions CS1-CS2 “Print With Preview”).

Select Color Management and make certain “Separations” is
selected.

If Separations is not selected, the films will not print.

Now select Output within the print dialog box and check “Labels” so each film is
marked with the appropriate ink color name and verify the correct printer and
page size is selected.  At this point there’s no other settings or adjustments to
make, just click Print and each channel will image to film.



Printing A Separation Converted To Halftones Using Photoshop
Newer Photoshop Versions  •  CS6 - Creative Cloud

Above is a screen shot of the CS6 print window.

Printing a separation converted to halftones using Photoshop CS6 or higher is the
same as with older versions although Adobe has changed the appearance of the
Print screen. The primary thing that must be done is to select “Separations” within
Color Management.

So after selecting your designated printer, page size, etc., the Color Management
section is directly under it.  Make sure to select Separations.

Scrolling further down within the Print window is where you’ll find other print options
such as Labels, Register Marks, etc.

Once satisfied with the settings, just click Print and each channel will image to film.



The ability to print films and apply specific Line Screens, Angles and Dot Shape to
each Channel is essentially identical in Photoshop versions CS1 - CS4.

The only difference is the Print Dialog Box in CS1 and CS2 is different and having
to select “Print With Preview” from the File Menu as opposed to “Print”.

Since CS1 and CS2 are very old and rarely used, all illustrations here are taken
using CS4.  We’ll make note where older versions of Photoshop differ.

Printing Films Directly From Photoshop CS1-CS4

Make sure each channel needed is selected for
output by turning on the “eye” next to the
channel’s name.

CS3 - CS4:  Select “Print” from the File Menu
then select “Color Management” from the scroll-
ing box in the upper right corner. Below under Color Handling make certain
that “Separations” is chosen.

CS1 - CS2:  Select “Print With Preview” from the File Menu and check “Show More
Options” under the image preview window. Choose “Color Management” within the
scrolling box below and make certain “Separations” is chosen as the “Profile”.

If “Separations” is grayed out and not selectable, the RGB Channels have
not been deleted!

Prior to outputting any file to film from within Photoshop CS1 - CS4, its
important to delete the RGB Channels or any other composite channel
cluster above the channels of the color separation!  This is the exact
opposite of outputting Photoshop channel separations using Illustrator or
CorelDraw as the RGB channels need to be retained.

Beginning with Photoshop CS5, its no longer possible to specify line
screens, angles and dot shape from within Photoshop as the “Screen”
button has been removed from the program.  For those using Photoshop
CS5 or higher, see our instructions on printing Photoshop channel sepa-
rations using Adobe Illustrator or CorelDraw.



Select “Output” then click the “Screen” Button.
When the Halftone Screen Box appears, UNCHECK
“Use Printers Default Screen”.

The CS1 - CS2 print dialog box includes all functions
pictured here.  The buttons, etc. are just situated
differently on screen.

In the Halftone Screen Box, each
ink within the color separation
needs to be chosen and applied the
correct Frequency, Angle and Dot
Shape.  Once all have been set,
click OK.

The example here depicts a stan-
dard setting for simulated process
channels.

Assuming your Printer /
RIP and the proper page
size is chosen, the file is
ready to be sent to the
output device.

Always check Labels so
the ink color is printed on
each channel.  If register
marks were not added
using UltraSeps, check
Register Marks.



Printing With Photoshop CS5 Or Higher

For those using a newer version of Photoshop such as CS5, CS6 or Creative
Cloud, I highly recommend using Illustrator or CorelDraw to print from as Adobe
has removed the function from newer Photoshop versions which permits the
assignment of LPI, Angle and Dot Shape for each channel.

The next few entries in the User Guide covers this:
Printing Films Using Adobe Illustrator
Printing Films Using CorelDraw

We provide simple instructions on correctly saving separations from Photoshop
followed by using these illustration programs for film output.

I’d like to point out that it’s possible to output halftone separations to film directly
using newer versions of Photoshop.  The downside being the films will be pro-
cessed using the presets of your RIP and can’t be changed or overridden through
the print functions of Photoshop.  This is the reasoning behind using Illustrator or
CorelDraw as all output parameters can be changed easily.

Separations that don’t require halftones such as Index or Hard Spot Color
(files with no tints) can be printed from Photoshop CS5 or higher.

Separations that are converted to halftones using the No RIP functions of
UltraSeps can also be printed directly from Photoshop CS5 or higher.

In a nutshell, there’s different methods used to output multichannel Photoshop
color separations to film.

If whatever you’re doing now works, stick with it.

This Area Intentionally Left Blank



These instructions are for those using a RIP with an inkjet printer or a postscript laser
printer.  If a RIP is not available, see our instructions on printing separations from
Photoshop without a RIP.

Illustrator CS3 or higher can open or place Photoshop (PSD) color separation files
directly as native Photoshop files for film output.  It can also use Photoshop color
separations saved as a PDF.

Just save the color separation using Photoshop as you normally would and make sure
to KEEP the RGB Channels!  If the RGB Channels are deleted, you’ll receive an unsup-
ported color mode error and the file will not open or place into Illustrator.

If there’s no RGB channels, then simply make 3 blank channels and move them to
the top of the channels panel above all the colors of the separation.

Next in Photoshop go to Image > Mode > RGB Color.  This converts the image to RGB
format and retains the separation intact.

It doesn’t matter if the RGB channels are blank as the external program just needs
them to read and open the file.

An Action to automatically add RGB Channels to your image can be downloaded here:
http://ultraseps.com/download/add-rgb-channels.zip

Delete all other channels not required for film output.

Now just OPEN this file using Illustrator or use the PLACE command to insert into an
existing Illustrator document and follow instructions on the following pages to send
the separation to film.

Printing Films Using Adobe Illustrator

The sample below is exactly how the file needs to appear in
Photoshop prior to saving with the RGB Channels included.



Now within Illustrator, Go to File > Print and choose your Printer (RIP).
Click on Output and within “Mode” choose “Separations (Host Based)”.
All of the channels of the separation are now active in the Ink Options window.

Deselect all Process Colors and only select the channels required for film output.
Change the Frequency, Angle and Dot Shape of each channel to be output to
film.  The file is now ready to send to the printer.

Never name any of the color channels “black, yellow, cyan or magenta” when
saving a color separation in Photoshop that is to be printed from an external
application.

Doing so will be confusing when printing the separations as multiple colors of the same
name will be seen within the print dialog functions.  Its also possible that printing er-
rors will result or the file may refuse to open.

Therefore, when naming these common color channels, always label them “black ink”
or “yellow ink” or just add something else to its name such as a PMS number.



Register marks can be added by using Illustrator’s standard marks, adding
marks to the file using the UltraSeps Actions prior to saving the separation or
creating your own custom vector register mark with Illustrator is a great idea.

Just design a register mark with Illustrator using the color “Registration”.  The
mark can then be duplicated and placed exactly where you’d like them and
they’ll print on each channel.

Save the register mark created for use on all files printed from Illustrator or
make a few templates of different film sizes with the marks added.

Potential Warnings When Opening A Photoshop
Channel Separation With Illustrator:

Unsupported Color Mode Or Depth indicates the file doesn’t include composite
color mode information such as RGB Channels.  If so, go back to Photoshop
and add RGB channels.  As discussed previously, the RGB can be void of any
data.  An Action to automatically add RGB Channels to your image can be
downloaded here: http://ultraseps.com/download/add-rgb-channels.zip

The Color Book warning below I’ve only seen with Illustrator CS6 on a few occa-
sions.  It can be ignored and the file will still print correctly although the preview
will look wrong.

To fix, go back to Photoshop and double-click one of the channels within the
error followed by clicking the small color chip in the Spot Channel Options.  Next
in the Color Libraries window click the Picker button.  In the color picker window,
change one of the values of the R-G-B slightly such as changing the G (Green)
from 132 to 133.  Click OK and then OK again.  Do this for each channel gener-
ating an error when opening with Illustrator to resolve the error.



Printing Films Using CorelDraw X5+

File Ready To Be
Saved As A PDF.

RGB Channels Intact

These instructions are for those using a RIP with an inkjet printer or using a
postscript laser printer.  If a RIP is not available, see our instructions on printing
separations from Photoshop without a RIP.

If using CorelDraw to output your Photoshop channel color separations, the easi-
est method is to save the file in Photoshop as a PDF.

When saving the PDF from Photoshop, make sure the RGB channels have not
been deleted as they are needed.

If there’s no RGB channels, then simply make 3 blank channels and move them
to the top of the channels panel above all the colors of the separation.

Next in Photoshop go to Image > Mode > RGB Color.  This converts the image to
RGB format and retains the separation intact.

It doesn’t matter if the RGB channels are blank as the external program just
needs them to read and open the file.

An Action to automatically add RGB Channels to your image can be downloaded
here: http://ultraseps.com/download/add-rgb-channels.zip

The sample below is exactly how the file needs to appear in Photoshop prior to
saving as a PDF with the RGB Channels included.

Never name any of the color channels “black, yellow, cyan or magenta”
when saving a color separation in Photoshop that is to be printed from an
external application.

Doing so will be confusing when printing the separations as multiple colors of the
same name will be seen within
the print dialog functions.  Its
also possible that printing errors
will result or the file may refuse
to open.

Therefore, when naming these
common color channels, always
label them “black ink” or “yellow
ink” or just add something else
to its name such as a PMS
number.



In CorelDraw go to File > Open and open your PDF file into CorelDraw.
Select Print from the File Menu.
In the General Window, select your RIP or Printer.

Next select the Color Tab and click the Print Separations button.



In the Separations Tab, deselect the process colors on the top of the list and
make sure all the colors within the color separation are checked.

Next click the “Advanced” button in the Separations Tab in the window above
which opens the Advanced Separations Settings window below.  Set the appro-
priate LPI Frequency and angle for each color in the separation.  The shape of
the dot can also be selected next to Halftone Type.  If the process colors are
checked in this window, deselect them.  When finished click OK.

Now just click OK in the Print window and the separation will be sent to your RIP
or postscript printer for film output.



Printing Index Color Separations

Index Separations are bitmaps, so the easiest way to print this type of file is
directly with Photoshop.  And since we’re not dealing with grayscale channels, a
RIP isn’t required if not available.

Prior to the following instructions on how to print Index separations to film,
there’s a few things that need to be known about Index separations.

Do not attempt to resize an Index separation as it will result in poor
output quality.

Art that contains excessive gradients or fade off into the shirt are not good
choices for Index.

Index separations “usually” require more colors to print accurately.  Of course,
this all depends on the art.

An Index separation is a multichannel bitmap file that doesn’t use halftones.
The color channels with Index are comprised of tiny squares.  The higher the
resolution of the original image, the smaller the squares will be.  If the original
file resolution is high such as 300 dpi, these squares will be far too small.

Work with images at 175 dpi - 200 dpi when generating Index separations.  If
needed, resample the file to the appropriate resolution.

Do not attempt to set any screen angles or LPI settings prior to output. Just
print out each channel to film using default settings.

The channels can not be adjusted (darkened - lightened) with Index.

The only changes that can be made to the Index separation is changing the
color and name of a channel.

If a change or adjustment is needed with an Index job, the entire separation
usually needs to be done again from the beginning.

Index separations can appear grainy on screen, especially at higher zoom lev-
els.  This is normal.

Overall, Index separations print much better than its screen preview indicates.

Once on press, Index jobs sometimes require more time to blend correctly so
its usually a good idea to run a few additional test prints.

Index jobs are very forgiving and extremely easy to control on press.



Make sure the RGB or any other
composite channels above the
separation are deleted.

Make sure all channels are turned
on with the “Eye” visible next to
each.

Next choose Print
(In Photoshop versions CS1-CS2
“Print With Preview”).

Select Color Management and
make certain “Separations” is
selected.

If Separations is not selected, the films will not print.

Printing Index Separations to film is identical to printing halftone separations
directly from earlier versions of Photoshop but without applying screens,
angles and dot shape to each channel as its not required.

Within the Print Dialog Box, select “Color Management” in the upper right
corner and then choose “Separations”.

Printing An Index Separation Using Photoshop
Older Photoshop Versions  •  CS1-CS2-CS3-CS4-CS5



Next select “Output” in the upper right corner.

Make sure the correct Printer is selected along with the page size.

Check “Labels” so the color of each channel is listed on the film.

If register marks have not been added previously, check “Register
Marks”.

Click “Print”.

And that’s it.  There’s nothing else to do.

Each channel will now print to film.



Above is a screen shot of the CS6 print window.  The preview may appear very
grainy as compared to earlier Photoshop versions.  This is normal.

Printing an Index separation using Photoshop CS6 or higher is the same as with
older versions discussed previously although Adobe has changed the appearance of
the Print screen.

So after selecting your designated printer, page size, etc., the Color Management
section is directly under it.  Make sure to select Separations.

Scrolling further down within the Print window is where you’ll find other print options
such as Labels, Register Marks, etc.

Once satisfied with the settings, just click Print and each channel will image to film.

Printing An Index Separation Using Photoshop
Newer Photoshop Versions  •  CS6 - Creative Cloud



Suggested Film Output Settings

Simulated Process Separations:

Dot Shape - Elliptical

All films 26 Degrees at 55 LPI.

Mesh count 280 - 305 Top Colors.

Mesh count 156 - 230 Underbase White.

Mesh count 200 - 230 Highlight White.

CMYK Separations:

Dot Shape - Elliptical

All films 22.5 Degrees at 55 or 60 LPI.
(26 Degrees can also be used)

Mesh count 305 - 330  Top Colors.

Mesh count 200 - 230 Underbase White.

Mesh count 230 Highlight White.

Print Order: White Base - Yellow - Magenta
                    Cyan - Highlight - Black

Grayscale Separations:

Dot Shape - Elliptical

All films 26 Degrees at 55 LPI.

Mesh count 280 - 305 Top Colors.

Mesh count 156 - 230 Underbase White.

Mesh count 200 - 230 Highlight White.

Duo-Tri-Quad Tone Separations:

Dot Shape - Elliptical

All films 26 Degrees at 55 LPI.

Mesh count 280 - 305 Top Colors.

Mesh count 156 - 230 Underbase White.

Mesh count 200 - 230 Highlight White.

Index Separations:

No Frequency, Screen Angles or Dot Shape Required.

Mesh count: 280 - 305 Top Colors.

Mesh count: 156 - 230 Underbase White.

Mesh count: 200 - 230 Highlight White.

Index Separations With
Halftone White Base & Highlight Channels:

(Settings For Underbase & Highlight Only)

Dot Shape - Elliptical

Underbase & Highlight - 26 Degrees at 50 LPI.

Mesh count 156 - 230 Underbase White.

Mesh count 200 - 230 Highlight White.

Basic Spot Color Separations:

Dot Shape - Elliptical

All films (No Tints - All Solid Colors) 26 Degrees at 300 LPI .

All films (With Tints And Gradients) 26 Degrees at 50 LPI .

Mesh count 156 - 200 (designs using no white base).

Mesh count 200- 305 Top Colors (designs with a white base).

Mesh count 156 - 200 Underbase White.

Manual Printing Notes:

Some printers who print manually might want
to experiment with using lower LPI settings
and mesh for simulated process work.  Such as
230 mesh for the top colors along with output-
ting films at 45 LPI - 50 -LPI at 26 degrees.



Troubleshooting - Questions

Since Photoshop and computer operating systems are constantly changing, I’ve
decided its no longer plausible to include troubleshooting information within the
user guide as the Support Page on our website is continually updated with new
information.

The Support Page includes solutions to just about every question we’ve ever
received.

Users of UltraSeps v3 should disregard any reference to unlocking or authoriz-
ing UltraSeps on the support page as this has been removed with Version 3.
Also disregard any reference to QuickLicense and errors pertaining to it.

http://www.ultraseps.com/support.php

If your question cannot be resolved through the use of the support
page, direct all technical support questions to:

support@ultraseps.com

Include the name or company the copy of UltraSeps is registered to.  We’ll re-
spond to the question within 24 hours or usually the same day if received be-
tween 10:00 am - 6:00 pm (New York City Time).

We’ve found it far more effective to address technical support via email as our
response can be precise along with directing you to links and information to re-
solve the issue easily.  And since we have a global user base, its makes sense to
address all support via email.

If your technical support issue is image specific, please email a low resolution
copy to us.  A 100 dpi jpeg is sufficient.  Without seeing the file, its very difficult
to offer assistance.

If UltraSeps is generating an error message that can’t be resolved through the
support page, please include a screen shot of the error attached to your email.

UltraSeps includes 1 year of free technical support.  Although once the year has
expired, we’ll continue to address basic questions at no charge.

Technical Support



As the developer of UltraSeps Version 3,  I’d like to convey my deepest
thanks for your trust in my product.  Hopefully it will enhance the capabilities
of your artistic endeavors, streamline your art department and make your life
a little easier.

Steve Roginski
Developer

www.ultraseps.com  /  info@ultraseps.com

Thank You!



Copyright and License

UltraSeps Version 3 for Windows® and Macintosh®

UltraSeps Version 3 ©2018 Steve Roginski, Extreme Sportswear, Extreme
Graphics Technology LLC - All Rights Reserved. UltraSeps™, UltraSeps
CSS™, UltraSeps v2™, UltraSeps v3™ and the UltraSeps Logo are trade-
marks (TM) of the copyright holder.

This software includes a “Single User License” to operate UltraSeps Version
3 on two computers.  Both installations may be accessed simultaneously.

The License may not be transferred to another party without the express,
written consent of Steve Roginski, Extreme Sportswear, Extreme Graphics
Technology LLC. Doing so violates the license agreement.

The Licensee agrees to delete UltraSeps Version 3 and all files required by
the program (actions, settings, scripts, plugins, user guide, video, etc.)
from a computer the Licensee intends to sell, discard, give as a gift, donate
or redistribute in any manner whatsoever.

All scripts, actions, plugins, code, settings, techniques, concepts, text,
video content along with the general look, feel and function of UltraSeps
Version 3 are the intellectual property of the copyright holder and may not
be copied, mimicked or emulated in any manner whatsoever.

You may not copy, emulate, clone, rent, lease, sell, modify, decompile,
disassemble, otherwise reverse engineer, or transfer the licensed program
or any subset of the licensed program.

Any such unauthorized use shall result in immediate and automatic termi-
nation of this license and may result in legal actions filed and pursued.

UltraSeps Version 3 is distributed “as is”.  No warranty of any kind is ex-
pressed or implied.  Use UltraSeps Version 3 at your own risk.  The devel-
oper will not be held liable for data loss, damages, loss of profits or any
kind of loss while using or misusing this software.

Once purchased, UltraSeps Version 3 is non-returnable due to the nature of
the product (software).  No refunds will be granted under any circum-
stances.

1 copy of the program and all inclusive files may be made for archival
purposes only.

The installation of UltraSeps Version 3 signifies acceptance of these terms
and conditions of the license.

Steve Roginski, Extreme Sportswear, Extreme Graphics Technology LLC
reserves all rights not expressly granted here.

UltraSeps Version 3
A Product Of Extreme Sportswear
www.ultraseps.com / info@ultraseps.com

Thank You!
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